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Chapter 17: Real-Time Entry:
HyperScribe and
Transcription Mode
HyperScribe Tool
What it does
The HyperScribe Tool is Finale’s real-time transcription tool; you use it to transcribe a live keyboard performance instantly into notation as you play, even onto two staves. When you click this
tool, the HyperScribe Menu appears; it contains all the commands you need to describe to Finale
the music you’re about to play. See RECORDING WITH HYPERSCRIBE. See also APPENDIX–QUANTIZATION SETTINGS GUIDE.
If you plan to use a MIDI Guitar for input, see TO CONFIGURE A MIDI GUITAR FOR ENTRY.
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Special mouse clicks
•

Click a measure to indicate where you want the transcription to begin.

•

After playing only partway into a measure, ctrl-click the screen to end the HyperScribe
session without affecting the half-completed measure. (You’d do this if there was some music
already in that measure that you wanted to preserve.)

HyperScribe Menu
How to get there
Click the HyperScribe Tool

g. The HyperScribe Menu appears.

TOC

What it does
Before you transcribe a real-time performance, there are a few things Finale needs to know about
the music you’re about to play. For example, you need to tell Finale what rhythmic value you’ll be
using for your key or foot taps as you play, and the value to which you want your performance
quantized. This menu lets you make these settings, which have a great deal to do with the quality
of the resulting transcription. Be sure to see also RECORDING WITH HYPERSCRIBE, and Installation & Tutorials.
Use HyperScribe’s Playback and/or Click command in the Beat Source submenu to control what
you hear when you use HyperScribe to enter your music. Listen to just a metronome click, or listen to an instant playback of the staves that you’ve selected in the Instrument List. If you prefer,
you can also play back staves while an accompanying metronome click provides a beat reference.
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HyperScribe Menu
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The Playback and/or Click command supports the click and countoff options for HyperScribe
playback and recording.
The Record Mode submenu has commands for transcribing a performance into a single staff or
two staves, and the multitrack recording command that lets you record simultaneous input from
multiple channels into multiple staves or multiple layers of staves.

TOC

Index

•

•

Beat Source: Tap • Playback and\or Click • External MIDI Sync. Using this submenu, you Next
Chapter
tell Finale what MIDI signal will serve as the tempo reference while you play—and who will
provide it (either you or Finale). Choose Tap if you’re going to be tapping a pedal or a key
Previou
while you play; the Tap Source dialog box appears (see TAP SOURCE DIALOG BOX).
Choose Playback and/or Click if you want Finale to provide a metronome click for the beat.
When Playback is checked, Finale uses the settings for the metronome click sound and the
countoff measures speciﬁed in the Click and Countoff dialog box. If you have chosen Tap as
your Beat Source, Finale will ignore the settings in the Click and Countoff dialog box. For
details, see CLICK AND COUNTOFF DIALOG BOX and PLAYBACK AND/OR CLICK DIALOG BOX.
Finally, choose External MIDI Sync if you’re using HyperScribe to transcribe music being
played by an external sequencer or another computer that’s equipped to transmit a MIDI Sync
signal. Finale will wait for such a signal from the external sequencer, at which point Finale
will automatically “sync up” to it, transcribing the music as it goes. No tapping (or even playing) is necessary.
Record Mode: Record into One Staff • Split into Two Staves • Multitrack Record. Choose
Record into One Staff to have Finale transcribe your music onto a single staff. Choose Split
into Two Staves to transcribe the music onto two staves at once. Recording a piano part for
example. For these two record options, Finale records information from the Receive On channel set in the HyperScribe Options dialog box, and plays the click and countoff (if one was
set) speciﬁed in the Click and Countoff dialog box. See HYPERSCRIBE OPTIONS DIALOG BOX,
CLICK AND COUNTOFF DIALOG BOX and PLAYBACK AND/OR CLICK DIALOG BOX.
For details, see RECORDING WITH HYPERSCRIBE—To record into one or two staves.
Choose Multitrack Record to record a performance from multiple channels into multiple
staves, or into multiple layers of a staff or staves. When you’re using multitrack recording,
Finale refers to the Instrument List to determine the staff or staves to record into and the channels to record from. For details, see INSTRUMENT LIST WINDOW, PLAYBACK AND/OR CLICK
DIALOG BOX and RECORDING WITH HYPERSCRIBE—To use multitrack recording (HyperScribe).
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Tap Source dialog box
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Note: Finale always uses the record settings for each staff in the Instrument List when you’re
multitrack recording; if you don’t get the results you expected, check that the RChan setting in
the Instrument List matches the incoming channel of your MIDI device and make sure that the
staff is selected to record into (a triangle appears in the R column for the staff).
•

HyperScribe Options. Choose this item to display the HyperScribe Options dialog box,
which holds a number of specialized transcription choices. See HYPERSCRIBE OPTIONS DIALOG BOX.

•

Transcription Mode. Select this item to enter Transcription mode. See TRANSCRIPTION
MODE for more information.
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Tap Source dialog box
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How to get there
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Click the HyperScribe Tool

g, and choose Tap from the Beat Source submenu of the Hyper-

Scribe Menu.

What it does
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When you use HyperScribe to transcribe a real-time performance, Finale needs to know where the
beats fall in relation to the music you’re playing. One of the easiest ways to provide a tempo reference is to tap in time with your own playing by either playing a note on a MIDI device or using a
foot pedal. As long as your taps and your playing are synchronized, with this option, you can
speed up or slow down and Finale will still transcribe the performance correctly.
In this dialog box, you tell Finale what key, pedal, or controller you’ll be tapping to provide a
tempo reference as you play.
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•

Standard Sustain Pedal • Nonstandard Sustain Pedal • MIDI Note: • Channel: • Listen.
If you’ll be needing both hands for your performance, you might opt to tap the foot pedal to
provide a tempo reference. Standard Sustain Pedal is the standard MIDI instrument sustain
pedal (Controller #64). Nonstandard Sustain Pedal refers to Yamaha sustain pedals and a few
others, whose pedal down/pedal up polarity is reversed (relative to most pedals).
If you’ll only be playing with one hand, you can use the other to tap a key to serve as the
tempo reference. Click MIDI Note. Then type a key number into the MIDI Note text box
(middle C = 60) and the Channel text box.
Instead of typing numbers, you can let Finale fill in these text boxes automatically—click Lis- TOC
ten, whereupon Finale will prompt you to play a key. Finale will enter the correct information.
(If Finale doesn’t respond when you play a key or pedal, then your MIDI system may not be
connected properly. For help, see TROUBLESHOOTING.) See LISTEN DIALOG BOX.
Index

•

Other • Select. If the beat reference will be neither a pedal nor a key, click Other. Then click
Select to display the MIDI Event dialog box, where you can specify any other MIDI signal to
Next
serve as the beat reference. See MIDI EVENT DIALOG BOX.

•

Tap equals • EDUs. Click the note duration you would like to use for your tap beat. Type in
the number of EDUs for any duration that is not available from the palette.
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Tap States dialog box
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•

Tap States • Select. If there’s a meter or tempo change in the piece you intend to play, you can
switch beat and quantization setups in midstream using Tap States. Click Select to enter the
Tap States dialog box; see TAP STATES DIALOG BOX for a full description. To return to a single
tap/quantization setup, deselect the Tap States checkbox.

•

OK • Cancel. Click OK (or press enter) to conﬁrm, or Cancel to discard, your selection of tap
signal and return to the score.

Tap States dialog box
How to get there

g

Click the HyperScribe Tool
. From the Beat Source submenu of the HyperScribe Menu,
choose Tap; click the Tap States Select button.

What it does

TOC

Index

Next
Chapter

Every now and then, you may need to transcribe a piece in which the meter or the “feel” changes.
Instead of making you interrupt your transcription to change the tap equals and smallest note set- Previou
tings, Finale lets you preprogram three additional settings, allowing you to switch freely from one Chapter
to the next in the middle of your performance. You create these settings, or states, in this dialog
box.

TOC

•

Tap States 1. The number identiﬁes which of the three extra HyperScribe “setups” you’re
going to be editing. Click the small up or down arrow buttons to cycle between states 1, 2, or
3.

•

Tap Equals; Select • Smallest Note; Select • MIDI Trigger; Listen. In the ﬁrst text box,
Next
enter the rhythmic duration of the each tap, in EDUs (1024 per quarter note). Or simply click Chapter
Select; the Set Durations dialog box appears. Click the desired tap value and click OK; Finale
fills in the Tap Equals text box for you.
Previou
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The Smallest Note is your quantization value. This is the smallest note you will be playing.
Click Select and the Set Duration dialog box appears where you can select the note duration
(including a dot if needed). Finale fills in the Smallest Note text box for you. See SET DURATION DIALOG BOX for more information.
The three MIDI Trigger text boxes display MIDI codes identifying the trigger that will make
Finale switch to the next Tap State you’ve deﬁned. The quickest way to enter these values is to
click Listen, then simply play the key or pedal you want to designate as a trigger. Note that in
order to switch to a different Tap State setup, you don’t start tapping a different key or pedal—
TOC
you continue to use the same tap device. Just tap the desired Tap State’s trigger once to tell
Finale you’re changing the meter or “feel”; then continue playing (and tapping the same tap
device).
Index
(Note: You can specify the three Tap States in addition to the “main” duration/division setup
you establish in the Tap Source dialog box. As you play, you can switch freely among Tap
States 1, 2, and 3, as described above. However, you can’t switch back to the “main” duration/ Next
Chapter
division setup while you’re playing.)
•

OK • Cancel. Click OK (or press enter) to conﬁrm, or Cancel to discard, the Tap State settings
Previou
you’ve made and return to the Tap Source dialog box.

Chapter

MIDI Event dialog box
How to get there

g

Click the HyperScribe Tool
. From the Beat Source submenu of the HyperScribe Menu,
choose Tap or Playback and/or Click. In the dialog box that appears, click Other (or choose Other
from the Start Signal for Recording drop-down list).

What it does
When you’re preparing for a HyperScribe recording, Finale needs to know what MIDI signal will
serve as the tempo reference (or the metronome “trigger”). This dialog box lets you choose a
MIDI signal not already listed in the dialog box.
TOC
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[Code text boxes] • Listen. Unless you’re a MIDI programmer, ignore the codes. Instead,
click Listen; Finale will ask you to play the MIDI signal, and it will enter the codes automatiPreviou
cally.

•

OK • Cancel. Click OK (or press enter) to conﬁrm, or Cancel to discard, your speciﬁcations
of a MIDI signal. You return to the previous dialog box.

Chapter

Playback and/or Click dialog box
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Playback and/or Click dialog box
How to get there
Click the HyperScribe Tool
of the HyperScribe Menu.

g. Choose Playback and\or Click from the Beat Source submenu

What it does
Use the Playback and\or Click dialog box to set the recording tempo, to deﬁne a start signal for
recording, and to select whether staves play back while Finale records your performance.
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•

Beat equals • EDUs. Click the note duration you would like to use for your beat. Type in the
number of EDUs for any duration that is not available from the palette.

•

Tempo • Listen. Finale will use this tempo for all HyperScribe record modes. Type the tempo
into the text box, or click Listen and the Listen to Tempo dialog box appears; then tap the
tempo on your MIDI keyboard or in the dialog box with your mouse. Finale will ﬁll in the
tempo for you. See LISTEN TO TEMPO DIALOG BOX.

•

Play Staves While Recording. Select this option if you want staves selected in the Instrument TOC
List to play back. Playback and/or Click must be selected in the Beat Source submenu. See
INSTRUMENT LIST WINDOW.
Note: Finale will not play back staves if either Tap or External MIDI Sync is selected in the
Beat Source submenu.

•

Start Signal for Recording: None (Record Immediately) • Any MIDI Data • Standard
Sustain Pedal • Nonstandard Sustain Pedal • Current Metronome Sound • Other. Choose
None (Record Immediately) for Finale to start recording without waiting for any signal to
begin. Choose one of the other options to have Finale start recording upon input of any MIDI
data; when you press a standard (or a nonstandard) sustain pedal; or when the current metronome click is played, respectively. To deﬁne a start signal that is not listed, choose Other; the
MIDI Event dialog box appears, where you can enter values for the MIDI event. Or, click Lis-
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ten, then play the MIDI signal; Finale will enter the settings for you. See MIDI EVENT DIALOG
BOX.
Note: The Start Signal for Recording setting is used only when you’re recording (and Playback and/or Click is selected in the Beat Source submenu), not when you’re playing back your
music.
•

Click and Countoff. Click this button to display the Click and Countoff dialog box where you
can set various options for the metronome click. See CLICK AND COUNTOFF DIALOG BOX.

•

Cancel • OK. Click OK (or press enter) to conﬁrm the new settings, or click Cancel to discard TOC
any changes you made. You return to the score.

Listen to Tempo dialog box

Index

How to get there
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g

Click the HyperScribe Tool
. From the Beat Source submenu of the HyperScribe Menu,
choose Playback. Click the Tempo Listen button.

What it does

Previou
Chapter

When you choose to have Finale provide a metronome click while you play a piece that you want
HyperScribe to notate, the easiest way to indicate the click tempo is to click the Listen button.
This dialog box lets you know that Finale is listening; while it’s on the screen, tap any key or click
your mouse on the dialog box in rhythm. Finale will compute (and display) the average tempo of
your taps.

TOC

•

OK • Cancel. When you’re ﬁnished tapping to teach Finale the tempo you want, either click
Cancel (to undo the tempo-setting you’ve just done) or OK (to conﬁrm it) and return to the
Playback and\or Click dialog box.
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Fixed Split Point dialog box
How to get there

g

HyperScribe: Click the HyperScribe Tool
. Choose Split into Two Staves from the Record
submenu of the HyperScribe Menu.
Or, choose Transcription Mode from the HyperScribe Menu and click a measure. Choose Fixed
from the Split Point submenu of the Transcription Menu.

TOC

What it does
When you’re playing a two-handed keyboard performance into Finale, it needs some instructions Index
for splitting the incoming music onto separate staves. This option lets you designate a note on
your MIDI keyboard as the “split point” pitch. All notes on or above this pitch are transcribed onto
the upper staff, and all notes below it are assigned to the lower staff.
Next
Chapter
Previou
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•

•

•

Split at MIDI Note:. In this text box, you identify a MIDI Note below which all music should
be split onto the lower (left-hand) staff. This note is determined by the standard MIDI key
numbering system, where keys are numbered sequentially from left to right, and middle C is
60. Instead of ﬁguring out the number to enter here, you may ﬁnd it easier to use the Listen
button (see below).
Listen. When you click this button, Finale goes into “listen” mode, waiting for a MIDI signal.
(A message to this effect appears on the screen.) Simply play the desired note on your MIDI
device; Finale enters the appropriate key number in the text box.
OK • Cancel. Click OK (or press enter) to conﬁrm the split point and return to the score
(HyperScribe) or the Transcription window. Your transcription will now be correctly split onto TOC
two staves. Click Cancel to return to the score (HyperScribe) or the Transcription window
without specifying a split point. Your transcription will appear on a single staff.

HyperScribe Options dialog box
How to get there
Click the HyperScribe Tool

g. Choose HyperScribe Options from the HyperScribe Menu.

What it does
This dialog box contains some specialized settings to help you get the most accurate possible
HyperScribe transcription. For example, you can tell Finale what MIDI channels to transcribe or
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HyperScribe Options dialog box

17-10

whether the program should devote computer power to keeping the screen display up to date. You
also have access to global quantization settings by clicking the Quant Settings button.

TOC

Index

•

Tie Across Barlines. If you anticipate that you’ll be sustaining pitches (for notes tied over
from one measure to another), select this option (so that a check mark appears). If not, leave
this option unselected. With this option off, Finale will never tie notes over barlines.
Hint: If you are having problems getting clean notation using this option, increase Remove
Notes Smaller than __ EDUs in the More Quantization Settings dialog box to 60 EDUs. See
MORE QUANTIZATION SETTINGS DIALOG BOX for more information.

•

Refresh Screen. If you’re playing too many notes, or too quickly, for the computer to keep up
with you, de-select Refresh Screen and try the transcription again. By relieving the computer
of the task of redrawing the screen, you let it give more of its processing capacity to transcribing your music.

•

Show HyperScribe Dialog Box. Select this option to display the HyperScribe dialog box
which displays the selected options for smallest note and duration. See HYPERSCRIBE DIALOG
BOX.

•

Receive On All Channels • Only Channel: ___. If you’re using HyperScribe to transcribe a
sequence being played by an external sequencer, you can specify that only one MIDI channel
be transcribed at a time, making it easier for you to transcribe one staff at a time.

Next
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If that’s the case, select Only Channel, and enter the MIDI Channel number in the text box.
Otherwise, select All Channels; HyperScribe will transcribe the music it’s receiving on all
MIDI channels.

TOC

•

Quant Settings. Click this button to display the Quantization Settings dialog box where you
can set you quantization type, smallest duration, and other options. See QUANTIZATION SETTINGS DIALOG BOX.

Index

•

Cancel • OK. Click OK (or press enter) to conﬁrm, or Cancel to discard, the changes you’ve
made in this dialog box; you return to the score.
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HyperScribe dialog box
How to get there

g

Click the HyperScribe Tool
. From the HyperScribe Menu, choose HyperScribe Options.
Check Show HyperScribe Dialog then click OK. Click a measure in the score.

What it does
When you transcribe a real-time performance with HyperScribe with the HyperScribe dialog box
showing, the two large “buffer boxes” in the HyperScribe dialog box begin to ﬁll up with black
dots—left to right, top to bottom. Each time you play a note, a dot appears in the right buffer box.
Each time you tap (a key, a pedal, or whatever you’ve speciﬁed as your tempo reference tap), two
dots appear in the left buffer box.
In general, these buffers simply act as a gauge for you to see if your computer is keeping up with
all the MIDI information you’re generating. If either of the buffer boxes becomes completely
ﬁlled with dots, that’s your warning that the computer can’t transcribe the notes as fast as you’re
playing them; if you don’t slow down, Finale will begin skipping measures (leaving them empty)
in an attempt to catch up with you.

•

•

TOC
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Duration. This indicator reminds you which rhythmic value you told Finale you’d be tapping
on a key or pedal (with the Tap command [HyperScribe Menu]). The displayed number is in
EDUs, 1024 per quarter note. (A value of 512 signiﬁes eighth-note taps; 2048 indicates cuttime, or half-note, taps.)
Smallest Note. This indicator reminds you of the smallest note value you speciﬁed in the
TOC
Quantization Settings dialog box (Options Menu). For detailed instructions on the use of
HyperScribe, see RECORDING WITH HYPERSCRIBE and QUANTIZATION SETTINGS DIALOG
BOX.

Transcription Mode
What it does

Index
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The Transcription Mode is another real-time transcription mode; you use it to record a live keyboard performance, which you can then turn into notation.
The Transcription Mode differs from the rest of HyperScribe, however, in that after you’ve played Previou
Chapter
your piece, it retains your performance in a graphic sequencer-like window. (You can even save

Transcription Mode
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these performances as separate ﬁles on your hard disk and open them later.) See TRANSCRIBING A
SEQUENCE. See also APPENDIX – QUANTIZATION SETTINGS GUIDE.
The Transcription Mode borrows certain elements from a sequencer, but it exists for the purpose
of notating your performances. Unlike the rest of HyperScribe, in which you provide a tempo reference by tapping as you play or use a metronome, the Transcription Mode lets you provide these
taps after you’ve recorded the performance (or before or during, for that matter). While Transcription Mode’s gratiﬁcation isn’t instant, it offers you the chance to try various transcription settings,
quantization levels, and so on, without ever having to rerecord your original performance. See
QUANTIZATION SETTINGS DIALOG BOX.
If you haven’t worked with a sequencer before, you may encounter some terms that are new to
you; one example is quantization. Finale’s sense of rhythm is much ﬁner than ours; it perceives
subdivisions of rhythm down to 1024ths of a quarter note. Because Finale’s sense of time is so
precise, the program can round off, or quantize, your performance to the nearest eighth note, quarter note, or whatever rhythmic value you specify. If it didn’t, your transcription would be much
too accurate—it would be ﬁlled with 128th rests, hundreds of ties, and a forest of 64th notes.
Controllers are devices on your MIDI device that modify the music in some way: volume and
sustain pedals, pitch and modulation wheels, and breath controllers are some examples. You can
record any of this data when you use the Transcription Mode to transcribe your music; furthermore, using the MIDI Tool, you can graphically edit these controllers. See CONTINUOUS DATA.
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Transcription Mode
These are Time Tags, and this
is the Time Tag display area.
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This is the keyboard display are,
displaying notes you played.

These buttons
govern the
recording and
playback of
notes.

These buttons
govern the
recording and
playback of
Time Tags.

Click here to
begin recording
or playing
immediately.
Wait Till is like
a “pause” mode.
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These options let you retain the original “feel” of your
performance for playback later, even after the
performance has been transcribed.

Special mouse clicks
•

Click any measure in the score to enter the Transcription window, where you can record a
performance. When you turn your performance into notation, the transcription will begin in
the measure you clicked.

•

Click a measure after recording a performance to transcribe a single measure if you’ve
TOC
selected Transcribe in Measures in the Transcription window. This feature allows you to transcribe a measure at a time from your performance, so that the transcription can appear in nonconsecutive measures.

•

Ctrl-click a measure in the score to re-enter the Transcription window if you’ve been transcribing a performance one measure at a time, using the Transcribe in Measures option.
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Transcription Menu
How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click a measure. The Transcription Menu is one of the two Transcription Mode menus that
appear.

What it does

TOC

Once you’ve recorded a real-time performance in the Transcription window, Finale needs some
additional information before it can begin to transcribe. In this menu you can tell Finale
Index
whether—and how—you want the performance transcribed onto two staves; what level of quantization you want applied; what range of notes you want included and excluded from the transcription; whether or not the performance included inner voices; and so on.

Next
Chapter

Previou
Chapter

•
•

•

•

New Session. Choose New Session to clear your current transcription session.
Split Point: None • Fixed • Moving. If you’re recording a two-handed performance, you can
specify that Finale split the transcription onto two staves automatically. If you choose Fixed,
you can identify a key on your MIDI keyboard corresponding to a pitch that divides all upperstaff notes from all lower-staff notes. (See FIXED SPLIT POINT DIALOG BOX.)
If you choose Moving, Finale decides which music to put on each staff according to the width
of your hands, based on the hand width interval you enter in the dialog box that appears. The
advantage of this method of splitting your performance into right-hand and left-hand parts (as
compared with the Fixed option) is that Finale can track the positions of your hands as they
move up and down the keyboard, provided there’s a wide enough interval between them for it
to know which hand is which; you don’t have to specify a static split point. See MOVING SPLIT
POINT DIALOG BOX.
Choose None if you want the entire transcription written on a single staff.
Input Filter. Choose this command to display the MIDI Input Filter dialog box, in which you
can tell Finale to record only certain types of MIDI data from your performance. See MIDI
INPUT FILTER DIALOG BOX for a more complete discussion.
Transcription Filter. Choose this command to display the Transcription Filters dialog box, in
which you can specify certain MIDI channels and ranges of notes you want to include or
exclude from your transcription.
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If you’ve just played a multichannel sequence into the Transcription window (from an external
sequencer), for example, you’ll probably want the notes from each MIDI channel to be transcribed onto their own Finale staff. In this dialog box, you can specify a single MIDI channel
at a time for transcription, or as many as four channels. See TRANSCRIPTION FILTERS DIALOG
BOX for a more complete discussion.
•

View Resolution. When you choose this command, the View Resolution dialog box appears,
in which you can specify the amount by which you want to “zoom in” to the display area, so
that you can more easily view and edit individual notes or Time Tags. See VIEW RESOLUTION
TOC
DIALOG BOX for a more complete discussion.

•

Punch PreRoll. When you’re rerecording only a certain part of your performance, or punchIndex
ing in, you’ll probably want Finale to play a few seconds of the music just before the place
you want to rerecord, so you can hear the desired passage in context and in tempo. The dialog
box that appears when you choose this command allows you to specify how many seconds of
the existing music you want Finale to play before switching into record mode. See PUNCH IN Next
Chapter
PREROLL DIALOG BOX and PUNCH IN/PUNCH OUT—TO PERFORM A PUNCH IN AND OUT.

Time Tag Menu

Previou
Chapter

How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click a measure. You enter the Transcription window, where the Time Tag Menu appears.

What it does
Once you record a real-time performance in the Transcription window, Finale needs to know
where the beats and barlines fall in relation to the notes you played (in order to transcribe your
performance). To provide this information, you tap along with your music as it plays back (on a
key or pedal), providing Finale with a tempo point of reference. These taps are called Time Tags.
They appear at the top of the display area as small quarter notes (or eighth notes, or whatever
value you speciﬁed before recording them). Note that you can edit these tags manually—you can
either insert a new one by double-clicking in the Time Tag display area, or you can slide them horizontally. See TRANSCRIPTION WINDOW for complete details.
TOC
The Time Tag Menu contains a number of Time Tag–related commands. Using them, you can tell
Finale the duration of the tags you’ll be recording, adjust each to align with the nearest note, or
assign Measure Tags (a special Time Tag that tells Finale where the beginning of each measure
Index
falls in relation to the music you played).
Next
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Time Tag Menu
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•

Tag. Choose one of the three commands (Tag, Beat, Measure) to tell Finale what kind of Time
Tag you’ll be recording or editing. For full instructions on recording and editing Time Tags,
see TRANSCRIBING A SEQUENCE.
The Tag type is the normal Time Tag; with each tap on a key or pedal, you specify the position
of a beat. (You specify the rhythmic value of your taps by choosing the appropriate value from
the First Tag Is section of this menu.) When you’re ﬁnished recording these tags, a small quarter note symbol (or whatever note value you speciﬁed) appears at the top of the display area
for each of your taps.

•

Beat. The Beat type is a special Time Tag you’ll rarely need. It has no effect unless you’re
using the Convert to Time Signatures feature (described below), which creates meter changes
TOC
in the score based upon your measure and beat taps in the Transcription window. Each Beat
Tag you record (after recording normal Time Tags) is represented by a small accent symbol
(>) at the top of the Time Tag display area.
When creating these time signature changes, Finale creates a subdivision of the time signature Index
each time it encounters a beat tag in the Transcription window. By creating a beat tag on the
ﬁrst and fourth beats of a

5
--4

measure, for example, you signal Finale to divide the measure into

two primary pulses; it will create a
other examples.

3+2
-----------4

time signature (instead of

5
--- ).
4

See the ﬁgure below for
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The placement of Beat Time Tags tells Finale how to subdivide the numerator of the meter in each
measure. In each of the examples at left, look for the tiny accent mark (a Beat Time Tag) and note
how it affects the resultant meter (right).

•

Measure. The Measure type is a Time Tag you’ll only need to record in a separate pass (after
recording normal Time Tags) if the meter changes during the section you’re transcribing (and
you haven’t created these meter changes in the score in advance).
After selecting Measure from this menu, record your Measure Tags by tapping the downbeat
of each measure. When you’re ﬁnished, a small M appears at the top of the display area for
each of your taps. If you then choose Convert to Time Signatures (see below), Finale automatically changes the meters for the corresponding measures in the score. With this method, you
can automatically create a transcription of a complex-metered piece by tapping your Measure
Tags where you feel each measure should begin; in this way you avoid having to calculate and
insert the various time signatures manually.
However, if the time signature (or signatures) have been established in the score already—if,
for example, you’ve established a time signature with the Time Signature Tool that doesn’t
change at all during the piece—it’s much easier to choose Assign Measure Tags (see below)
instead of recording Measure Tags in a separate pass.

TOC

Index

In any case, you must create Measure Tags—by one method or the other—in order to transcribe your performance at all.
•

Next

Clear All Tags. Choose this command to delete all Time Tags, of all types, from the Time Tag Chapter
display area.
You can also remove just one Time Tag, or a few at a time, without using this command. To do Previou
Chapter
so, click the words Time Tag in the Transcription window. Drag across the Time Tags you
want to clear (in the upper strip of the display area) and press Delete.

Time Tag Menu
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•

Assign Measure Tags. When you choose this command, Finale puts Measure Tags into the
selected region of your performance automatically, based on the time signature in the score
(starting with the measure you clicked). Even if there’s a meter change in every measure of the
score, this is a quick, easy way to apply Measure Tags—which, incidentally, are mandatory if
Finale is to transcribe your performance.

•

Convert to Time Signatures. If the piece you’re transcribing contains changing time signatures, you can use this command to create the meter changes in the score automatically. (You
must ﬁrst record regular Time Tags before you begin the following steps.)
First record Measure Tags: Choose Measure from the Time Tag Menu, select the region for
which you want to record Measure Tags (or choose Select All from the Edit Menu), set the
Keyboard radio button to Play, set the Time Tag radio button to Record, and click Wait Till—
then tap a key or pedal at the downbeat of each measure while the music plays back.
When you’re ﬁnished, an M appears in the Time Tag display area for each of your taps. If you
want Finale to create composite time signatures (for example, to create a
5
--- ),
4

3+2
-----------4

TOC

Index

Next

meter instead of Chapter

record Beat Tags (see BEAT, above). Finally, make sure the desired region is selected, and

choose Convert to Time Signatures. Finale automatically changes the time signatures in the
corresponding measures in the score, based upon the placement of your Measure Tags and

Previou
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------- , for
Beat Tags. Finale will even create fractional and composite meters, if necessary ( 3.5
4

example).
•

Create Tags From First Two Tags. If the performance you created was in a fairly strict
tempo, you may not have to record Time Tags by tapping along with the entire performance
while it plays back. Instead, enter just two tags at the beginning of the recording. Make sure
they’re as accurately placed as possible; it’s a good idea to choose ALIGN TAGS TO NOTES at
this point (see below). Choose Select All from the Edit Menu (or select the region you want to
transcribe, beginning with the two Time Tags you placed manually). Choose this command;
Finale creates and places Time Tags automatically throughout the selected portion of your performance by extrapolating from the positions of the ﬁrst ones you entered.

•

First Tag Is: Half • Quarter • Eighth • 16th. With these commands, you tell Finale the rhythmic value of the ﬁrst Time Tag you tap. If you’ve also selected Record Equal Durations, this TOC
rhythmic value is assigned to all your taps.

•

If you want to create a Time Tag manually (by double-clicking in the Time Tag display area),
your selection from these commands also speciﬁes the rhythmic value of the Time Tag you
create. See TRANSCRIBING A SEQUENCE for full instructions on editing Time Tags manually.

Index

Record Equal Durations. You don’t have to tap steadily when you record Time Tags. You
could, in fact, simply tap along to your melody; Finale infers the rhythmic value of each tap,
even if it changes (qeeh, for example).

Next
Chapter

You’ll probably get the best results, however, if you choose Record Equal Durations; as your
piece plays back, tap the same rhythm throughout (just quarter notes, for example). You tell
Finale what that one rhythmic value is by choosing the appropriate FIRST TAG IS command
(see above).
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Click Input. Normally, when you record Time Tags in a separate pass (after recording your
performance), you can tap any key—you can even change keys during the process. As long as
the Keyboard Play radio button is selected, and the Time Tag Record radio button is selected,
Finale interprets a press of any key on MIDI channel 1 as a Time Tag.
With this command, you can tell Finale that you’ll be tapping a key on some other MIDI channel—or that you’ll be tapping a pedal or other controller instead of a key. You’ll also ﬁnd this
feature useful if you want to record your performance and the Time Tags simultaneously, so
that Finale knows what key (or controller) it should listen to for Time Tags (and not as part of
the performance itself). For example, you could tell Finale that you want to tap your foot on a
pedal (to provide Time Tags) while you play, as you do in HyperScribe. Likewise, you’d want
to use this method to transcribe a sequence from an external sequencer (one that provides a
click track Finale can use as the Time Tag source, for example). See CLICK INPUT DIALOG BOX
for a more complete discussion.
Click Output. Choose this command to display the Click Output Type dialog box, in which
you can specify which note and MIDI channel Finale should use when it plays back the Time
Tags.
There are two cases in which you might like Finale to play Time Tags as you record in the
Transcription window. First, you might want Finale to provide a “click track” as you record a
real-time performance, so that you won’t have to record Time Tags in a separate pass. The
“click track” is nothing more than playback of Time Tags that Finale has placed automatically;
see TRANSCRIBING A SEQUENCE–To hear a click track while recording in the Transcription
Mode for details on how to create a “click track”.
Second, you might want Finale to drive an external sequencer or computer using MIDI Sync,
so that the external device will play in tempo with Finale. (See MIDI SYNC for a full discussion.)
In either case, the Click Output Type dialog box lets you specify various characteristics of the
click: its pitch, duration, MIDI channel, and so on. See CLICK OUTPUT TYPE DIALOG BOX for
a more complete discussion.
Create Tags From Background File. This command is only available if you’re using a Background File, Finale’s “overdubbing tracks” mechanism. For full instructions on overdubbing
tracks, see TRANSCRIBING A SEQUENCE—To add tracks.
In a true sequencer program, you can record one track while listening to a previously recorded
track. In Finale, you achieve this effect by transcribing the ﬁrst track, creating a playback ﬁle
from it and reentering the Transcription Mode. Finale automatically loads the playback ﬁle
into the “background” of the new transcription window (and places an X in the Background
File checkbox). Thus, you hear the earlier tracks being playing back while you record the new
material.
The Create Tags From Background File command adds an extra convenience to this system.
Since any new tracks you record are presumably in the same time signature and tempo as the
ﬁrst one you transcribed, you don’t have to rerecord Time Tags in order to transcribe additional tracks, because Time Tags were already created with the ﬁrst transcribed track.
When you choose this command, Finale adds Time Tags to the selected region of your most
recent recording automatically, based on the positions of the Time Tags in the Background
(Playback) File (which contains the playback of the tracks you’ve already transcribed). You
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still need to insert Measure Tags, however—choose Assign Measure Tags from the Time Tag
Menu.
Note that if you’re interested in obtaining the most accurate possible transcription of your new
track, you should also choose Align Tags to Notes from the Time Tag Menu (see below). But if
you want to preserve the rhythmic nuances of your new track so that it plays back as accurately as possible once it’s transcribed, don’t select Align Tags to Notes, even though the transcription may not be as accurate.
•

Align Tags to Notes. After you’ve recorded a MIDI performance and then told Finale where TOC
the beats fall by entering Time Tags, use this command to align the tags more precisely with
the beginnings of the notes in your performance. (Specify the region for which you want Time
Tags aligned either by dragging through part of the keyboard display area or by choosing
Index
Select All from the Edit Menu.) In effect, you’re “quantizing” the tags to the nearest notes, so
that Finale understands that the tag and the note fall exactly together.
The Align Time Tags To Note Starts dialog box appears; the number in the text box tells Finale
how far from each tag it may “search” for a note with which to align it. If the performance was
slow, you can increase this number; if it was very fast and “notey,” you may want to use a
smaller number so as not to move Time Tags inadvertently, for example, to the note after the
one with which it should align. See ALIGN TIME TAGS TO NOTE STARTS DIALOG BOX.
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Transcription window
How to get there
Click the HyperScribe Tool
Click a measure.

g, and select Transcription Mode from the HyperScribe Menu.

What it does
In this window, you can record and play back your performances, “punch in and out,” and record
and edit both notes and Time Tags. In creating the transcription, you can also capture certain
rhythmic and dynamic elements of your performance pertaining to its “feel,” which Finale can recreate when it plays back the transcribed notation.
When you record a performance (see TRANSCRIBING A SEQUENCE), the notes you played appear
as thin horizontal lines in the Keyboard display area (the lower part of the display area, marked at
the left edge by a piano keyboard). The length of each line corresponds to its duration, and its vertical position corresponds to the “keys” of the on-screen piano keyboard. You can edit these notes
graphically, changing their durations, inserting new notes, or deleting notes from selected areas.
See Keyboard, below.
Once you’ve recorded your performance, Finale needs to know where the beats and barlines fall in
relation to the notes you played. To provide this information, you can tap along with your music
(on a key or pedal) as it plays back, providing Finale with a tempo reference. These taps are called
Time Tags. They appear as small quarter notes (or whatever note value you speciﬁed before
recording) in the top half-inch or so of the screen—the Time Tag display area—marked at the left
side by a metronome.

TOC

Index

Next
Chapter
Previou
Chapter

Transcription window

17-21

Note that you can save a Transcription window recording of your performance into a separate ﬁle,
called a Note File, by choosing Save As from the File Menu. The ﬁle you create has a unique
extension (*.NOT), and is completely independent of the normal Finale document (consisting of
notation) you have open. Choose Open from the File Menu to open an existing Note File. Choose
New from the File Menu to create a new, empty Transcription window.
Because the File Menu’s New, Open, and Save As commands—when you’re in the Transcription
window—only apply to performances you’ve recorded, you can think of the Transcription window as a completely independent mini-program. You can ﬂip back and forth between the actual
score and the Transcription window: click the Cancel button to return to the score (your recorded
performance is preserved), and click any measure to return to the Transcription window. You can
even close your Finale document and open a different one; when you enter the Transcription window, your most recently recorded performance will still be there.
Finally, in addition to the two display areas in the graphic part of the window, there are two sets of
radio buttons on the right side of the screen. They’re labeled Keyboard and Time Tag. By making
sure the correct radio button is selected before you click Start (or Wait Till), you can tell Finale
exactly what you’re about to record (or listen to).
For example, to record Time Tags, you’d want the Play radio button selected in the Keyboard section, because you’ll want to hear your performance playing back so you can tap along with it.
You’d want the Record radio button selected in the Time Tag section, to tell Finale to interpret
your key taps as beat indications.
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Keyboard. The word Keyboard (on the right side of the window) has two purposes. First, it
identiﬁes the three radio button options beneath it (see below). Note that it’s possible to have
no radio buttons selected; click a selected button again to “deselect” it.
Second, you can click the word Keyboard to highlight it; by doing so, you’ve just indicated to
Finale that you’ll be editing the recorded notes directly. To delete notes, drag through their
starting point and press Delete. To insert a new note, double-click in the Keyboard area. When
you double-click, a new note appears, whose pitch is determined by the location of your click;
use the piano keyboard at the left side of the screen as a guide. The note’s default duration is
1.5 seconds. If you keep the mouse button pressed after your second click, you can drag backward to increase the duration of the note. You can also make existing notes longer or shorter—
just double-click the beginning or ending of a line; on the second click, keep the mouse button
pressed and drag left or right. (You can magnify the Keyboard display area if you ﬁnd the
“notes” too small to manipulate; just choose View Resolution from the Transcription Menu. In
the dialog box that appears, enter a smaller value—20, for example—to enlarge the display.
Click OK.)
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Technical note: When you double-click to create a new note, its default duration is actually 15
units, where a unit is determined by the number in the View Resolution dialog box (choose
View Resolution from the Transcription Menu). In other words, if the View Resolution is 100
(thousandths of a second), the note produced by a double-click is 1500 thousandths of a second long—which is 1.5 seconds.
Record at End. When this radio button is selected, Finale starts recording any new music you
play at the end of the music you’ve already recorded, if any. (If there’s none, Finale simply
records your new music at the beginning of the Transcription window.) Click Start or Wait Till
to begin recording.
Punch In/Out. When this radio button is selected, Finale records over a region of music; you
specify the region by setting the In: and Out: counters in the lower right corner of the screen.
(Note that you can also set these counters simply by dragging through [highlighting] the
music you want to record over in the display area.)
This feature allows you to rerecord only part of a performance that was otherwise perfect, for
example. (By clicking the Keyboard Play radio button and the Time Tag Record radio button,
you can also rerecord Time Tags for a certain passage.) You can tell Finale to play a “countoff”
measure or so of music before switching to “record” mode, if you want; choose Set Punch
PreRoll from the Transcription Menu, and enter the number of seconds of music you want to
hear before Finale starts recording. Click Start or Wait Till to begin recording.
Play (Keyboard section). When this radio button is selected, Finale plays the selected music
when you click Start. You select music by dragging through it in the display area, so that it’s
highlighted. To select the entire performance, choose Select All from the Edit Menu.
Time Tag. The label Time Tag (on the right side of the window) has two purposes. First, it
identiﬁes the three radio button options beneath it (see below). Note that it’s possible not to
have any of the radio buttons selected; click a selected button again to “deselect” it.
Second, you can click the words Time Tag to highlight them; by doing so, you’ve just indicated to Finale that you’ll be editing the Time Tags directly. To insert a new Time Tag, doubleclick in the Time Tag display area; its duration (Half, Quarter, Eighth, Sixteenth) and its type
(Time Tag, Measure Tag, or Beat Tag) are determined by the appropriate settings in the Time
Tag Menu. (You can’t insert Measure or Beat Tags until after you’ve entered standard Time
Tags.) To move a Time Tag, drag its notehead. If you select a group of tags (by dragging
through them or by choosing Select All from the Edit Menu), drag any one notehead to move
them all.
To change the duration of a tag, double-click its notehead—but on the second click, hold the
button down. Drag left or right. As you drag the Time Tags, they cycle through the durational
values: sixteenths, eighths, quarters, and so on. Drag to the right for larger values, to the left
for smaller values. If you select a range of tags (by dragging through them or by choosing
Select All from the Edit Menu), you can use this technique to effectively renotate an entire
4
--4

2
--4
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time, for example, or vice versa—because you’re effec- Chapter
tively telling Finale that every quarter note is now an eighth note (in this example). If you try
this, however, don’t forget to choose Assign Measure Tags again from the Time Tag Menu
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You can magnify the display area if you ﬁnd the Time Tags too close together to manipulate;
just choose View Resolution from the Transcription Menu. In the dialog box that appears,
enter a smaller value—20, for example—to enlarge the display. Click OK.
Record. When this radio button is selected, Finale will interpret a tap on any key (on MIDI
channel 1) as a Time Tag. You can specify which kind of Time Tag—and what its rhythmic
value is—by choosing the appropriate commands from the Time Tag Menu. (See TIME TAG
MENU for a complete description of the commands.)
You’ll usually want to select the Play radio button in the Keyboard section while you do this,
in order to hear your performance playing back so you can tap along with it. Note, however,
that you can record Time Tags and a performance simultaneously—if you want to tap the
pedal as you play (as in HyperScribe), for example; or if you’re recording a sequence being
played by an external sequencer (one that can provide its own click as it plays). In these cases,
select Record At End (Keyboard section) and Record (Time Tag section), after ﬁrst letting
Finale know which signal to interpret as the Time Tags by choosing Click Input from the Time
Tag Menu. (See CLICK INPUT DIALOG BOX.)
Click Start to begin recording immediately, or click Wait Till, which will make Finale wait, in
pause mode, until your ﬁrst tap. Your ﬁrst tap is recorded.
Play [Time Tag section]. Select this radio button if you want Finale to play the Time Tags
you’ve already recorded. You might use this feature as a metronome, for example.
To specify the note (or other MIDI signal) you want Finale to use as the “click” sound, choose
Click Output from the Time Tag Menu. (See CLICK OUTPUT TYPE DIALOG BOX.)
Set to. Instead of recording Time Tags by tapping along as your performance plays back, you
can enter evenly spaced Time Tags automatically. This feature is most useful if you create
these Time Tags before you record your performance. Finale will play them as you record,
serving as a metronome or click track for you to play along with.
The number you enter in the text box is the metronome setting (beat notes per minute) at
which you want Time Tags placed. (You deﬁne “beat” by your selection from the Time Tag
Menu: Half, Quarter, Eighth, or Sixteenth.) Finale places these evenly spaced tags only in the
region speciﬁed by the In: and Out: counters (see below) in the lower-right corner of the
screen. (See TRANSCRIBING A SEQUENCE–To hear a click track while recording in the Transcription Mode for complete instructions for this process.)
Finally, to record your performance while Finale provides the click, click Record at End (Keyboard section); click Start or Wait Till, and begin.
Wait Till. Click this button to put Finale in “pause” mode. Only when you produce any MIDI
signal—play a note or tap a pedal, for example—does Finale begin to record or play, according to your radio button selections. Note that the ﬁrst MIDI signal you produce isn’t merely a
trigger; it’s actually the ﬁrst event recorded. For example, if you want to record Time Tags by
tapping a key, your ﬁrst key tap not only starts Finale recording but also serves as the ﬁrst
Time Tag (if Wait Till is selected).
To stop recording or playing, click anywhere except on a button.
Start. Click Start if you want Finale to begin recording or playing immediately, according to
your radio button selections in the Keyboard and Time Tag sections. To stop, click anywhere
except on a button.
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Now:. This indicator displays the precise temporal position of the cursor as you move it
through the display area, expressed in the Hours:Minutes:Seconds:Thousandths of a second
format. (Until the music is converted into standard notation, Finale refers to points in your
performance in terms of real time.)
In: [Counter] • Out: [Counter]. These indicators specify the starting and ending points of the
selected region, expressed in the Hours:Minutes:Seconds:Thousandths of a second format. To
edit these numbers directly, click the word In or Out and change the numbers by typing new
values.
You may ﬁnd it easier, however, to select a region by simply dragging through a section of the
display area. These counters change automatically to reﬂect your selection. You can also set
either indicator by clicking—click the word In: or Out:, then click in the display area. To
select the entire recorded performance, choose Select All from the Edit Menu.
Double-click the word In or Out to scroll the display area so that the beginning or ending point
you’ve speciﬁed scrolls into view.
Start: [Counter]. This counter tells Finale at what point it should begin playing the background ﬁle (see Background File, below). The counter displays real time, in the Hours:Minutes:Seconds:Thousandths of a second format. To edit these numbers directly, click the word
Start and change the numbers by typing new values (or by clicking in the display area).
Reset Counters. Occasionally, you may record a few moments of silence at the beginning of a
performance you recorded. Click this button if you want Finale’s counters (Now, In, Out, and
Start) to consider your ﬁrst note their “zero” point (instead of the beginning of the silence).
Save Tempo Changes • Save Continuous Data. These options tell Finale to remember the
precise “feel” of your original performance, and to keep this data handy for playback once you
return to the score. If you don’t choose these options, then when you play back the transcribed
music from the score, Finale will simply play the “sheet music”—the notated version, which
will be rhythmically precise but expressionless and “square”—instead of an exact re-creation
of your original performance. (Important note: To play back your music with these captured
nuances, make sure the corresponding checkboxes are selected in the Playback Options dialog
box; see PLAYBACK OPTIONS DIALOG BOX and the SAVE TEMPO CHANGES DIALOG BOX)
There are four kinds of playback data Finale stores invisibly with the notes in your score. Key
Velocity data describes how hard each note was struck, which usually determines how loudly
it plays back. Note Durations means Start and Stop Time data, the small rhythmic deviations
from the beat that give a performance a certain rhythmic feel; swing, rolled chords, and rushing the beat. Continuous data is data generated by the pitch wheel, patch changes, and controllers such as pedaling. And Tempo Changes, in this case, are tempo changes you created
by using the Transcription Mode and adding Time Tags; see TRANSCRIBING A SEQUENCE.
To capture this information with the Transcription Mode, select the four corresponding checkboxes before transcribing your performance. Continuous Data and Tempo Changes are available in the Transcription window. Key Velocity and Note Durations options are accessed
through the Quantization Settings dialog box in the More Quantization Settings dialog box as
part of Finale’s global quantization settings. See MORE QUANTIZATION SETTINGS DIALOG
BOX.
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Background File. In a true sequencer program, you can record one track while listening to a
previously recorded track. You achieve this effect in Finale by transcribing the ﬁrst track, creating a playback ﬁle from it, then reentering the Transcription Mode; Finale plays the playback ﬁle in the “background” while you record the new track. For step-by-step instructions,
see TRANSCRIBING A SEQUENCE—To add tracks.
After you’ve created a playback ﬁle (consisting of the tracks you’ve already transcribed),
Finale automatically loads it into the “background” of the Transcription window, ready to play
back when you record a new track. To let you know that it’s prepared to do so, it displays an X
TOC
in the Background File checkbox. If you don’t want to hear the previously transcribed tracks
while you make a new recording, click Background File, then Cancel.
Index
If you want to load a different playback ﬁle, click Background File. An Open dialog box
appears, displaying any such ﬁles you’ve created; double-click the one you want to hear in the
“background.”

Note that you can also specify where you want the Background File to begin its playback by
entering the precise time in the Start: counter (see below). Note, too, that once you’ve
recorded a new track, you don’t have to reenter Time Tags manually—you can tell Finale to
use the Time Tags you entered in the earlier tracks. To do so, select the region for which you
want Time Tags inserted (or choose Select All from the Edit Menu), then choose Create Tags
From Background File. (See TIME TAG MENU.) You still need to insert Measure Tags, however, so choose Assign Measure Tags from the Time Tag Menu.
•
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Transcribe in Measures. In some situations, you may not want your performance transcribed
entirely onto a single staff. If you’re orchestrating, for example, you might want the ﬁrst few
measures of the transcription to appear in one staff, and the next few on another staff.
If so, select this option. When you return to the score, Finale won’t transcribe anything until
you click a measure, into which Finale then transcribes the ﬁrst measure of your performance.
Click another measure (in any staff) to transcribe the next measure, and so on.
Because you usually click a measure to enter the Transcription window, you need to ctrl-click
a measure to do so if you’re in Transcribe in Measures mode.

•

Quant Settings. Click this button to display the Quantization Settings dialog box. In this dialog box and the More Quantization Settings dialog box, you can set various options that affect
quantization in Finale including the Transcription Mode. See QUANTIZATION SETTINGS DIA- TOC
LOG BOX and MORE QUANTIZATION SETTINGS DIALOG BOX for more information.

•

Transcribe. After recording your performance, adding Time Tags, adding Measure Tags, editing the tags and notes as desired, and setting the quantization and split point parameters from Index
the Transcription Menu, you’re ready to have Finale transcribe the performance. Make sure
the music you want transcribed is selected (highlighted). Click Transcribe.
Next

Finale begins to notate the transcription on the measure you clicked (to enter the Transcription Chapter
window) and continues on subsequent measures. If you’ve speciﬁed a Split option, Finale
notates the transcription on the staff you clicked and the one just below it.
•

Cancel. Click Cancel to return to the score without transcribing your performance. Your performance, however, is preserved in its current state, along with any Time Tags and menu settings you’ve made. To return to it, click the Transcription Mode and click any measure.

Previou
Chapter

Moving Split Point dialog box

17-27

Moving Split Point dialog box
How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click a measure. You enter the Transcription window; choose Moving from the Split Point submenu of the Transcription Menu.

What it does

TOC

The Moving Split option tells Finale to transcribe your performance onto two staves. To decide
which music to put on each staff, Finale splits the performance into “right-hand” and “left-hand”
Index
parts according to the widest interval you spanned with one hand during your performance, based
on the number you enter into this dialog box. The advantage of this method of splitting your performance into right- and left-hand parts (as compared with the Fixed split point option) is that
Next
Finale will be able to follow your hands as they move up and down the keyboard, provided there’s Chapter
a wide enough interval between them for it to discern which hand is which.
Previou
Chapter
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Current Right Hand Position • Current Left Hand Position. These indicators let you know
where Finale believes your right and left hands to be as it transcribes the music you’ve
recorded. The default right hand position is 65, and the default left hand position is 48; these
numbers correspond to synthesizer keys in the MIDI key numbering system (middle C is key TOC
number 60).
If you’ve transcribed any part of your performance, these indicators change to tell you where
Finale believes your hands to have been at the end of the transcribed portion. To reset these
numbers to the default values (65 and 48), click Reset.

Index

•

Hand Width. In this text box, enter the widest interval, in half steps, played by either hand
during your performance. Instead of calculating the number of half steps, you can click Listen Next
Chapter
to MIDI, which allows you simply to play the interval.

•

Listen. Click this checkbox to let Finale know you’re about to play an interval representing
Previou
your hand width. With one hand (anywhere on the synthesizer), play the widest interval
Chapter
played by either hand during your performance. The alert is no longer displayed, and the Hand
Width text box displays a number corresponding to the width interval.

MIDI Input Filter dialog box
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•

Reset. Click this button to set the current left and right hand positions back to their default
MIDI note values of 65 and 48, respectively.

•

OK • Cancel. Click OK (or press enter) to conﬁrm, or Cancel to discard, the hand-width settings you’ve just made. You exit the dialog box.

MIDI Input Filter dialog box
TOC

How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Index
Click a measure. When the Transcription window appears, choose Input Filter from the Transcription Menu.

What it does

Next
Chapter

This dialog box lets you specify which kinds of MIDI information you want recorded from your
performance. A MIDI event is any MIDI signal—a note, a press of the sustain pedal, a patch
Previou
change, and so on. (When you use the pitch wheel, you may generate a stream of hundreds of
Chapter
MIDI events.)
Finale gives you the option of “ﬁltering out” certain kinds of MIDI data. If you’re interested only
in producing notation, for example, you may not want Finale to consume memory and disk space
by recording pedaling, patch changes, and so on. In this dialog box, you tell Finale which kinds of
MIDI data you want recorded.

TOC

Index

Next
Chapter

•

Notes. Select this checkbox if you want the notes of your performance recorded.

•

Pitch Bends. Select this checkbox if you want Finale to record pitch bend information during
your performance.

Previou
Chapter

Transcription Filters dialog box

17-29

•

Program Changes. Select this checkbox if you want Finale to record program (patch)
changes during your performance.

•

Listen. Click Listen if you want to select the appropriate items in this dialog box (including
entering controller numbers in the text boxes) simply by playing your music. As you play,
Finale will automatically select the information types it “hears” during your performance.

•

Controllers: All • Only. Controllers include pedals, the modulation wheel, and so on (except
the pitch wheel, which has its own button). If you want Finale to record every kind of controller information generated during your performance, select the Controllers checkbox and the
TOC
All button. If you only want to record the data generated by certain controllers, select the Controllers checkbox and click Only, then enter the controllers’ numbers, if you know them, into
the four text boxes. If you don’t know a controller’s number, click in a text box, click the Lis- Index
ten checkbox, and “play” the controller in question. Finale will enter its number in the text
box automatically.

•

OK • Cancel. Click OK (or press enter) to conﬁrm, or Cancel to discard, the settings you’ve
made in this dialog box and return to the Transcription window.

Transcription Filters dialog box

Next
Chapter
Previou
Chapter

How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click a measure. Choose Transcription Filter from the Transcription Menu.

What it does
In this dialog box, you can specify certain MIDI channels and ranges of notes you want to include
or exclude from the transcription. You could, for example, specify that only the notes within a certain octave range to be transcribed, even though your performance included notes all over the keyboard.
If you’ve just played a multichannel sequence into the Transcription window (from an external
sequencer), for example, you’ll probably want the notes from each MIDI channel to be transcribed onto their own Finale staff. In this dialog box, you can specify a single MIDI channel at a
TOC
time for transcription, or as many as four channels.
Similarly, if you just entered a keyboard performance that you want transcribed by register—for
example, you want to transcribe only the notes above middle C—you can use this dialog box to
Index
specify a range of notes for transcription.

Next
Chapter
Previou
Chapter

Transcription Filters dialog box
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TOC

Index

Next
Chapter

•

Channel. In this column of text boxes, you can specify up to four MIDI channels you want
transcribed from the recorded performance.

Previou
Chapter

Suppose, for example, you’ve just played a sixteen-channel sequence from an external
sequencer into the Transcription window, and you want the contents of each channel to appear
on its own Finale staff. Choose Transcription Filter from the Transcription Menu, and enter 1
in the ﬁrst Channel text box. In the Low and High text boxes, enter 1 and 200—unless you
only want to include a certain range of notes in the transcription (see KEY RANGE: LOW/HIGH,
below). Proceed with the transcription in the usual way; Finale will notate only the music it
received from channel 1 of the original sequence. Repeat the process with the other MIDI
channels (transcribing one at a time onto different staves).
•

Key Range: Low • High • Listen. In each pair of Low/High text boxes, enter a low and a high
key number to specify the range of notes you want to transcribe. (Middle C is key number 60,
and the numbers increase sequentially as you move up the keyboard.)
Note that you don’t have to calculate the key numbers and type them in manually. An easier
method is to click the Listen button beside each pair of text boxes, and play the notes—the
lowest, then the highest; Finale enters their key numbers in the text boxes automatically.

TOC

In this way you can specify up to four different ranges of notes you want transcribed from
your performance. You can use these text boxes to exclude notes from the transcription, too,
Index
by entering a higher value in the Low text box than the value in the High text box. If you want
to transcribe all notes except for middle C, for example, enter 61 in the Low text box and 59 in
the High text box (middle C is key number 60).
Next
•

Use Filters • No Filters. Click Use Filters to conﬁrm (or No Filters to discard) your MIDI
channel and note range selections. You return to the Transcription window. A check mark
appears beside the Transcription Filter command in the Transcription Menu when the ﬁlters
are in use.

Chapter
Previou
Chapter

View Resolution dialog box
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View Resolution dialog box
How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click a measure. Record some music. Choose View Resolution from the Transcription Menu.

What it does
In this dialog box, you can specify the amount by which you want to “zoom in” to the display
area—for example, in order to have better manual editing control over the tiny Time Tags. A
smaller number in this dialog box magniﬁes the display area; in any case, Finale only magniﬁes
your view horizontally, so that the thin lines representing the notes you played are stretched horizontally, but still align correctly with the keyboard at the left side of the screen.
The View Resolution also determines the initial duration of any new note you create by doubleclicking in the keyboard display area (the bottom three-quarters of the display window). Its
default duration is 15 units, where a unit is equal to the number in this text box. In other words, if
the View Resolution is 100 (thousandths of a second—that is, one-tenth of a second), the note produced by a double-click is 1500 thousandths of a second long, which is 1.5 seconds. See TRANSCRIPTION WINDOW for further details on editing notes and Time Tags.

•

Index

Next
Chapter
Previou
Chapter

Each unit in the viewing area equals __ /1000th(s) of a second. In this text box, enter the
number, in thousandths of a second, you want to be represented by a single screen dot (pixel)
in the display area of the Transcription window. Enter a small number (15 or 20) to “zoom in”
TOC
on the notes and Time Tags so you can manipulate them at a higher resolution. Enter a high
number (200 or 400) to “zoom out” so that you can see a larger portion of your recorded performance.
Technical note: The number in the View Resolution text box actually speciﬁes the time, in
thousandths of a second, represented by a single dot (pixel) on the screen. Suppose the View
Resolution is set to 1000 (thousandths of a second); when you move a Time Tag one pixel to
the right, you’ve just shifted it one second in real time.

•

TOC

OK • Cancel. Click OK (or press enter) to conﬁrm, or Cancel to discard, your change in view
resolution. You return to the Transcription window.

Index

Next
Chapter
Previou
Chapter

Punch In PreRoll dialog box
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Punch In PreRoll dialog box
How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click a measure to enter the Transcription window. Choose Punch In PreRoll from the Transcription Menu.

What it does
If you’re recording a real-time performance in the Transcription window and make a mistake, you
don’t have to rerecord the entire sequence. You can, instead, punch in and out, meaning that you
can rerecord only those few seconds of the original performance that need replacing.
You’ll probably want Finale to play a few seconds of the music just before the spot you want to
rerecord, however, so you can hear the desired spot in context and in tempo. This dialog box
allows you to specify how many seconds of the existing music you want Finale to play before
switching into record mode (at which point you should begin to play the new music).
For full instructions for performing a punch-in, see PUNCH IN/PUNCH OUT–To perform a punch in
and out.

TOC

Index

Next
Chapter
Previou
Chapter

•

Play the note ﬁle for __ second(s). In this text box, enter the number of seconds of music you
want Finale to play just before the punch-in point. (Enter zero if you don’t want any “pre roll”
at all.)

•

OK • Cancel. Click OK (or press enter) to exit this dialog box and return to the Transcription TOC
window. When you click Start, Finale plays the music preceding the punch-in point for the
number of seconds you speciﬁed, then begins recording your new performance. Click Cancel
to disregard any changes and return to the Transcription window.
Index

Next
Chapter
Previou
Chapter
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Click Input dialog box
How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click a measure in the score and choose Click Input from the Time Tag Menu.

What it does
After recording a real-time performance in the Transcription window, you generally have to make
a second pass, during which you tap in tempo along with the playback of your performance, telling Finale where the beats fall in relation to the notes you played. You don’t have to choose the
Click Input command at all, in this case; if you’re recording Time Tags in a separate pass, Finale
assumes that any key you tap is meant to be the tempo tap, provided that (1) you’ve remembered
to click the Record button under the words Time Tag, and (2) that you’re transmitting the Time Tag
signal on MIDI channel 1. See TRANSCRIPTION WINDOW.
If, however, you want to record the performance and the Time Tags simultaneously, use the Click
Input command to help Finale distinguish between the notes of the performance and the note representing the tempo tap (for example, the highest key on the keyboard). If you plan to play a melody with one hand while tapping a key with the other, for example, use this command to tell
Finale what key you’ll be tapping. If you’re transcribing a sequence being played by your synthesizer or another computer capable of generating a MIDI click track, once more you can tell Finale
what to listen for. Finally, if you plan to transmit your Time Tags to Finale on any channel other
than MIDI channel 1, use this dialog box to specify the new channel.

TOC

Index

Next
Chapter
Previou
Chapter

TOC

Index

•

Input Code. These three text boxes display special codes which, taken together, identify the
MIDI event (tapping a key or pedal, for example) that Finale will be listening to as a tempo
reference (Time Tag input). Use the Listen button to change the codes in these text boxes.

•

Listen. When you click this button, Finale displays a message telling you that it’s “listening.” Chapter
The program will translate the next MIDI event you transmit—by tapping a key or pedal, for
example—into the MIDI codes. You’ve just speciﬁed the device (key, pedal, or controller) and
Previou
the MIDI channel Finale will listen to for Time Tags; now you’re ready to record Time Tags
Chapter
and a performance simultaneously.

Next

Click Output Type dialog box

•

•

•
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If the “Finale is listening” message doesn’t disappear when you play a key or pedal, then your
MIDI system is not connected properly (and Finale is receiving no MIDI events at all). For
help, see TROUBLESHOOTING.
Ignore First Data Byte. In short, this checkbox tells Finale how particular it should be about
the MIDI event it’s receiving—in other words, whether to consider any key (or controller) to
be a Time Tag, or only a speciﬁc key (or controller). As a practical consideration, don’t select
this checkbox if you plan to record both Time Tags and a keyboard performance simultaneously, because Finale needs to be tuned to a speciﬁc key (or controller) to register the Time
Tags in order not to confuse them with notes (or controllers) played in the performance. (Technical note: This option is called Ignore First Data Byte because it tells Finale to ignore the second text box—the ﬁrst data byte—when determining whether or not a MIDI event matches the
event you’ve speciﬁed for your Time Tags.)
Second Data Byte Greater Than Zero. This checkbox should almost always be selected. The
only time it shouldn’t be selected is when you’re recording a performance and Time Tags
simultaneously, and the Time Tags are being generated by a source (such as a drum machine)
that Finale could confuse with an actual note in the performance.
The “second data byte” is the one that lets Finale know the qualitative value of the speciﬁed
tag transmission—the key velocity of the Time Tags, for example. Therefore, unless you strike
the key with precisely the speciﬁed key velocity, Finale won’t know that a Time Tag has
occurred. Because a drum machine can generate a click track where every “tap” has a uniform
key velocity, you can tell Finale only to register incoming Time Tag signals with that speciﬁc
velocity by turning off this option; thus Finale won’t confuse the drum machine’s click track
notes with notes of the same pitch you happen to play during your performance, because it
will only register notes of the precise key velocity value you speciﬁed as Time Tags.
OK • Cancel. Click OK (or press enter) to conﬁrm your Time Tag input settings and return to
the Transcription window. Click Cancel to tell Finale to ignore any changes you made in this
dialog box and return you to the Transcription window. The default settings (a tap on any key
or pedal, over any MIDI channel, will be considered a Time Tag) remain in force.

TOC

Index

Next
Chapter
Previou
Chapter

Click Output Type dialog box
How to get there

g

TOC

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click a measure in the score and choose Click Output from the Time Tag Menu.

What it does
There are two cases where you might like Finale to provide a click track, or metronome, as you
record in the Transcription window. First, you might like Finale to provide a “click track” as you
record a real-time performance in the Transcription window, so that you won’t have to record
Time Tags in a separate pass. (The “click track” is nothing more than playback of Time Tags that
Finale has placed automatically; see TRANSCRIBING A SEQUENCE–To hear a click track in the
Transcription Mode.)
Second, you might want Finale to drive an external sequencer or computer using MIDI Sync signals, so that the external device will play in tempo with Finale. See MIDI SYNC.

Index

Next
Chapter
Previou
Chapter

Click Output Type dialog box
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In either case, the Click Output Type dialog box lets you specify various characteristics of the
click: its pitch, MIDI channel, length of a click, and so on.

TOC

Index

Next
Chapter
Previou
Chapter

•

•

Send MIDI Sync. Select this radio button if you want Finale to transmit MIDI Sync signals
instead of providing an audible click. If you have connected your computer to an external
sequencer (or another computer) that has been conﬁgured to interpret this kind of MIDI message, it will wait in “pause” mode until Finale begins play, at which point the two will play in
perfect synchronization.
Send MIDI, Channel:. Select this radio button if you want Finale to send the clicks via MIDI
(instead of transmitting MIDI Sync signals). The number in the text box speciﬁes the MIDI
channel over which Finale will transmit the click information. Finale will automatically ﬁll in
this text box and all others in this dialog box if you use the Listen to MIDI button.

•

Start Code: • Stop Code:. The codes in these two rows specify the MIDI signals (events) to
be sent at the beginning and ending of each individual click, and are used to compensate for
the idiosyncrasies of various synthesizers. Finale will ﬁll in these text boxes automatically if
you use the Listen button.

•

Listen. When you select this checkbox, Finale goes into “listening” mode. Finale will trans- TOC
late the next MIDI signal you transmit—by playing a key, for example—into the MIDI codes.
(Technically, Finale registers the next two MIDI events—a note on and note off command, for
example, that constitute a single key strike.) You’ve just speciﬁed the key and the MIDI chan- Index
nel Finale will play to create the clicks. (You might use the snare drum or clave sound on a
drum machine, for example.)

•

Click Duration. The number in this text box, in thousandths of a second, speciﬁes the exact Next
Chapter
duration of each click. In general, you’ll want this value to be fairly small, so that the click
sound will be short and sharp; the default value, 500, produces a click that lasts half a second.
Previou
Chapter

Align Time Tags to Note Starts dialog box

•

17-36

OK • Cancel. Click OK (or press enter) to conﬁrm the click settings you’ve made and return
to the Transcription window. Click Cancel to tell Finale to ignore any changes you made in
this dialog box. The default settings (MIDI channel 1, Start Code = note on, Stop Code = note
off, pitch = C above middle C with a key velocity of 64) remain in force.

Align Time Tags to Note Starts dialog box
How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click any measure. Choose Align Tags to Notes from the Time Tag Menu.

TOC

Index

What it does
After you’ve recorded a MIDI real-time performance and then told Finale where the beats fall by
entering Time Tags (see TRANSCRIBING A SEQUENCE), you can use the Align Tags to Notes command to align the tags more precisely with the beginnings of notes in your performance. In effect,
you’re “quantizing” the tags to the nearest notes, so that Finale understands that the tag and the
note should fall exactly together. In this dialog box, you specify, in effect, how sensitive you want
Finale to be as it “searches” for the nearest note attack.

•

•

Next
Chapter
Previou
Chapter

Search Width. The number in this text box, in thousandths of a second, tells Finale how far
from each Time Tag it may “search” for a note with which to align it. (The default is 200, or 1/
5 second.) If the tempo of the performance was slow, you can increase this number; if it was TOC
very fast and “notey,” you may be better off using a smaller number so as to avoid moving a
Time Tag inadvertently (for example, to the note after the one with which it should align).
OK • Cancel. Click OK (or press enter) to conﬁrm the search width setting and return to the
Transcription window. If you click Cancel, Finale ignores any changes you made in this dialog Index
box and cancels the Align Tags to Notes command.
Next
Chapter
Previou
Chapter

Save Tempo Changes dialog box
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Save Tempo Changes dialog box
How to get there

g

Click the HyperScribe Tool
, and select Transcription Mode from the HyperScribe Menu.
Click a measure. Record a performance and add Time Tags in the usual way. Click Save Tempo
Changes.

What it does

TOC

When you record a performance in the Transcription Mode, Finale offers you the option of preserving any tempo changes so that you can hear them later applied to the ﬁnished transcription.
Index
(To calculate this information, Finale compares the evenness of your Time Tags with real time; if
your Time Tags grow farther apart, for example, Finale infers a decrease in tempo.) In this dialog
box, you can specify how you want the tempo information captured.
Next
Chapter
Previou
Chapter

•

Do Not Save Tempo Changes. Click this radio button if you do not wish to save any tempo
changes.

•

Save Tempo Changes as an Absolute Tempo. Click this radio button if you want Finale to
remember each tiny tempo change as an absolute tempo change. In other words, Finale might TOC
think to itself: “60 beats per minute...65...70.” Any expression you place in the score (whose
playback deﬁnition has been set to affect tempo) will have no effect on the playback tempo.
Similarly, you can’t affect the playback tempo by adjusting the Tempo parameter on the PlayIndex
back Controls. This is the most precise method of preserving your tempo ﬂuctuations.

•

Save Tempo Changes as a Percent Alteration. Click this button if you want Finale to
remember each tiny tempo change as percentage of the tempo that preceded it. In other words, Next
Finale might think to itself: “60 beats per minute…8% faster…10% faster.”
Chapter
While this kind of tempo information is slightly less precise than the Absolute type, it allows
you to change the starting tempo (with an expression, or by changing the Tempo in the Playback Controls) without destroying the relative tempo changes from moment to moment.

Previou
Chapter

Recording with HyperScribe
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•

Save Tempo Changes as a Percent Alteration with an End-of Measure Reset. Click this
button if you want Finale to remember each tiny tempo change as percentage of the tempo that
preceded it (see “% Alteration,” below)—but to remember it in one-measure segments. Finale
keeps track of the tempo at the beginning of each new measure, therefore, making it easier for
you to edit the tempo for a speciﬁc measure with the Tempo Tool.

•

OK • Cancel. Click OK (or press enter) to retain tempo information, or click Cancel if you
decide you don’t want to retain tempo information with your transcription. You return to the
Transcription window.

Recording with HyperScribe

TOC

Index

When you’re recording a real-time performance using HyperScribe, you can provide the click
yourself by tapping a note on your MIDI keyboard, a foot pedal, and so on (if Tap is selected in
Next
the Beat Source submenu). Or, another computer or MIDI device can provide a time code that
Finale will sync to (if External MIDI Sync is selected in the Beat Source submenu). If you prefer, Chapter
however, you can have Finale provide a metronome click, which can be triggered by playing a
certain MIDI note (if Playback and/or Click is selected in the Beat Source submenu).
Previou

To record into one or two staves
•

From the Options Menu, choose Quantization Settings. Adjust the settings, then click OK.
See QUANTIZATION SETTINGS DIALOG BOX for more information.

•

Click the HyperScribe Tool

•

From the HyperScribe Menu, choose Beat Source, then Playback and/or Click. The Playback and/or Click dialog box appears. (See PLAYBACK AND/OR CLICK DIALOG BOX)
Click the note duration you would like to use for your beat. Type in the number of EDUs
for any duration that is not available from the palette.
If you know what tempo you want to record at, enter the tempo into the Tempo text box.
If you prefer to have Finale calculate the tempo for you, click Listen, then tap any key on your
MIDI instrument in the desired tempo. Finale will enter the tempo you play.
Choose a start signal from the Start Signal for Recording drop-down list. Finale will
delay starting the countoff measures and recording until it receives a start signal. Choose None
(Record Immediately) if you don’t want to use a signal to start recording—Finale will immediately start recording (after playing the countoff if one was speciﬁed); choose Any MIDI
Data for Finale to start recording upon receiving any MIDI signal that’s played; choose Current Metronome Sound to use the same MIDI signal as the metronome click; choose Standard
Sustain Pedal or Nonstandard Sustain Pedal to signal the start by depressing the foot pedal;
choose Other to deﬁne an alternate MIDI signal as the start signal in the MIDI Event dialog
box (see MIDI EVENT DIALOG BOX).
Select Play Staves While Recording if you want all the staves set up in the instrument list
to play back while Finale provides a click.
Click on Click and Countoff to set up your click and countoff options. For details, see
PLAYBACK – CLICK AND COUNTOFF.
Click OK. You return to the score.

•
•

•

•
•
•

Chapter

g. The HyperScribe Menu appears.

TOC
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Chapter
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Choose Record into One Staff or Split into Two Staves from the Record Mode submenu
of the HyperScribe Menu.
If you choose Split into Two Staves, the Fixed Split Point dialog box appears. Enter the
note that will serve as the split point for the staves. Or click Listen, and play the note on your
MIDI keyboard. Click OK. See FIXED SPLIT POINT DIALOG BOX for more information.
Choose HyperScribe Options from the HyperScribe Menu and change the Receive On
information if you’re sending information on an alternate channel. Change other settings
as needed, then click OK. See HYPERSCRIBE OPTIONS DIALOG BOX for more information.
To start recording, click the measure in which you want Finale to begin recording. Signal
Finale to start (if you selected a start signal). Click a measure. Or, choose Playback Controls from the Window Menu, if it isn’t already selected. If you have selected split into two
staves, click on the upper staff in which you want recording to begin. Change the measure if
necessary, then click Record in the Playback Controls.
Note: If you click a measure to start recording, Finale will start recording into the measure you
clicked, not the measure displayed in the Playback Controls.

TOC

Index

Next
Chapter

When you’re ﬁnished, if you are providing the beat, give one extra tap. The extra tap is
Previou
required to ﬁll out the beat, for the beneﬁt of Finale’s quantization feature.
Chapter
(Note: If you stop in the middle of a measure, Finale automatically ﬁlls the rest of the measure
with rests. If you’re HyperScribing over an existing passage and accidentally play partway
into an existing measure that you wanted to preserve, ctrl-click to end the recording; Finale
won’t transcribe the new notes you’ve played in the half-completed measure.)
Click anywhere on the screen to stop recording and exit the HyperScribe dialog box (if it
is displayed). If the quantization or split point settings weren’t quite right, change them; then
click the ﬁrst measure and try the performance again. HyperScribe will overwrite whatever
music is already on the staff. If you can’t seem to ﬁnd a split point that works to separate the
music into the proper staves, use the Note Mover to correct any split point errors (see To correct split point errors, below).

To use multitrack recording (HyperScribe)
When you’re using multitrack recording, remember to specify the recording options in the Instrument List window, otherwise Finale won’t know which staves to record into, or which channels to
receive from. As with other HyperScribe record modes, you can have Finale wait for a click (Tap TOC
or External MIDI Sync is selected in the Beat Source submenu). If you prefer, however, you can
have Finale provide a metronome click, which can be triggered by playing a certain MIDI note (if
Playback and/or Click is selected in the Beat Source submenu).
• Choose Quantization Settings from the Options Menu. Adjust the settings, then click OK. Index
See QUANTIZATION SETTINGS DIALOG BOX for more information.
•
•

Click the HyperScribe Tool

g. The HyperScribe Menu appears. The ﬁrst decision you

Next
Chapter

have to make is whether or not you want Finale to provide a click.
From the Beat Source submenu of the HyperScribe Menu, choose Playback and/or
Click. The Playback and/or Click dialog box appears. (See PLAYBACK AND/OR CLICK DIALOG Previou
Chapter
BOX)

Recording with HyperScribe
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Click the note duration you would like to use for your beat from the Beat Equals palette.
Type in the number of EDUs for any duration that is not available from the palette.
If you know what tempo you want to record at, enter the tempo into the Tempo text box.
If you prefer to have Finale calculate the tempo for you, click Listen (the Listen to Tempo dialog box will appear), then tap any key on your MIDI keyboard in the desired tempo. Finale
will enter the tempo you tapped. See LISTEN TO TEMPO DIALOG BOX.
Select Play Staves While Recording if you want all the set up staves in the instrument list
to play back while Finale provides a click.
Choose a start signal from the Start Signal for Recording drop-down list. Finale will
delay starting the countoff measures and recording until it receives a start signal. Choose None
(Record Immediately) if you don’t want to use a signal to start recording—Finale will immediately start recording (after playing the countoff, if one was speciﬁed); choose Any MIDI
Data for Finale to start recording upon receiving any MIDI signal that’s played; choose Current Metronome Sound to use the same MIDI signal for the metronome click; choose Standard
Sustain Pedal or Nonstandard Sustain Pedal to signal the start by depressing the foot pedal;
choose Other to deﬁne an alternate MIDI signal as the start signal in the MIDI Event dialog
box (see MIDI EVENT DIALOG BOX).
Click on Click and Countoff to set up your click and countoff options. For details, see
PLAYBACK – CLICK AND COUNTOFF.
Choose Multitrack Record from the Record Mode submenu of the HyperScribe Menu.
Choose Instrument List from the Window Menu, if it isn’t already selected. Click the
appropriate P (Play) or S (Solo) columns to determine which staves will play back as you
record. (For more information, see INSTRUMENT LIST WINDOW.)
Click in a staff’s R (Record) column to specify that music will be recorded into the staff
(a black triangle appears in the column). To record into different layers of a staff, expand
the staff list by clicking on the control arrow next to the staff name, then click in the Record
column for each layer you want to record into. Click again to remove a triangle from a staff or
layer previously selected for recording.
Enter the channel number that will be recorded for each staff or layer in the RChan column. To specify different channels for the layers of a staff, expand the staff list by clicking on
the control arrow next to the staff name, then enter the channel numbers into the RChan columns for those layers. Finale displays the word Mixed next to the Staff name in the RChan
column, indicating that Finale will be recording into one or more layers of the staff, from more
than one channel.
Close the Instrument List. Clicking on the minimize icon in the upper right corner.
Choose Playback Controls from the Window Menu, if it isn’t already selected. See PLAYBACK CONTROLS.
In the Measure text box, enter a new measure number to indicate where to start you
transcribing.
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When you’re ready to start recording, signal Finale to start (if a start signal was
selected). Click the Record button in the Playback Controls. Or, click a measure in your score
where you want recording to begin. Finale will use the settings in the Instrument List to determine which channels to receive from or which staves to record into, then begin countoff and
recording.
Note: If you click a measure to start recording, Finale will start recording into the measure you
clicked, not the measure displayed in the Playback Controls.
When you’re ﬁnished, if you are providing the beat, give one extra tap. The extra tap is
required to ﬁll out the beat, for the beneﬁt of Finale’s quantization feature.
(Note: If you stop in the middle of a measure, Finale automatically ﬁlls the rest of the measure
with rests. If you’re HyperScribing over an existing passage and accidentally play partway
into an existing measure that you wanted to preserve, ctrl-click to end the recording; Finale
won’t transcribe the new notes you’ve played in the half-completed measure.)
Click anywhere on the screen to stop recording and exit the HyperScribe dialog box (if it
is displayed). If the quantization or split point settings weren’t quite right, change them; then
click the ﬁrst measure and try the performance again. HyperScribe will overwrite whatever
music is already on the staff. If you can’t seem to ﬁnd a split point that works to separate the
music into the proper staves, use the Note Mover to correct any split point errors (see To correct split point errors, below).
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To record a performance
•

Create an empty score; establish the meter, key signature, and conﬁguration of staves.
You can transcribe onto one or two staves at a time.

•

Click the HyperScribe Tool
and select Transcription Mode from the HyperScribe
Menu. Click the measure at which the transcription will begin. You enter the Transcription
window.
Click Wait Till. Finale is in “pause” mode. The recording begins with the ﬁrst note you play
(or any other MIDI signal—be careful not to use the sustain pedal until you’re ready to
record).
Play your piece. Click anywhere (except on a button) to stop recording. When you stop
recording, you’ll see your music expressed as a sort of horizontal bar graph; the length of the
bars indicate the notes’ durations, and their relationship to the piano keyboard (left side of the
screen) indicates their pitch.
Hint: if your performance begins with a pickup measure, ﬁll the ﬁrst part of the measure with
“dummy” beats; the Transcription window always transcribes on the assumption that the ﬁrst
note is beat 1.

•

•
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If you want to preserve your performance as a sequence, choose Save As from the File
Menu. Note that as far as Finale is concerned, the Transcription window is a different program. The File Menu’s commands (New, Open, Save As) no longer refer to the Finale document (notation) you currently have open. They refer instead to the performance, or sequence,
you just recorded. If you choose New from the File Menu, for example, you’re specifying a
new sequence; you’re not creating a new Finale (notation) document.
When you save your Transcription window performance, you create a special Finale ﬁle called
a Note File. When you exit Finale and return to the desktop, you’ll notice that your note ﬁle
has a different icon. You can open this ﬁle any time you’re in the Transcription window; you TOC
can, for example, record a piece today, save it, and transcribe it tomorrow.
To play your performance back, choose Select All from the Edit Menu. The display area is Index
highlighted.
Under the word Keyboard, click Play; then click Start. Finale plays back your perforNext
mance.

To hear a click track while recording in the Transcription Mode
In the Transcription Mode, a click track is nothing more than playback of Time Tags that Finale
has placed automatically. You can specify various characteristics of the click: its pitch, MIDI
channel, length, and so on.
and select Transcription Mode from the HyperScribe
Click the HyperScribe Tool
Menu. Click a measure in the score. The measure you click will be the ﬁrst measure of the
transcription when you transcribe the performance. You enter the Transcription window.

•

Click the word In at the lower-right corner of the Transcription window, and enter the
time, in hours, minutes, seconds, and thousandths of a second, at which you want the
click track to begin. If you want the click track to begin immediately at the beginning of your
recording, leave the indicator set at 00:00:00:000. (Instead of typing numbers, you can also
specify the appropriate point in the music by clicking in the display area.)
Click the word Out at the lower-right corner of the Transcription window, and enter the
time, in hours, minutes, seconds, and thousandths of a second, at which you want the
click track to stop. In other words, if you guess that your performance will last two minutes,
type 2:00:000. (Instead of typing numbers, you can also specify the appropriate point in the
music by clicking in the display area.)
Instead of entering numbers with the In: and Out: indicators, you may prefer to simply drag
the mouse through the keyboard display area (marked by a piano keyboard at the left side).
The In: and Out: numbers will change to accurately record the width of the highlighted area.
Enter the tempo in the Set to text box. The number you enter here is a standard metronome
marking (beats per minute), and allows you to specify the tempo of the click track. (You set
the rhythmic value of this metronome setting—usually quarter notes per minute—using the
First Tag submenu of the Time Tag Menu.)
Choose Click Output from the Time Tag Menu. The Click Output Type dialog box appears.
Specify the sound of the click track by clicking Listen and playing the appropriate note.
Finale automatically takes note of the MIDI channel you used to generate the sample click.

•

•
•
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You might want to use a rim shot or other short percussive sound on a drum machine, or a very
high note on your MIDI keyboard. If you like, you can change the duration of the click sound
by changing the Duration number; the default duration is a half second.
Click OK (or press enter). You return to the Transcription window.
Click Wait Till. When you click Wait Till, Finale places a set of Time Tag note icons across
the top of the selected Keyboard region; when you begin to play, it will play each of these
back as one click of the metronome.
Finale is now in pause mode, awaiting the ﬁrst note of your performance. Make sure that the TOC
Record at End radio button is selected (under the word Keyboard) and that Play is selected
(under the words Time Tag).
Record your performance as usual. As you play, Finale will record your performance while Index
generating a click track of the tempo, sound, and duration you speciﬁed.

To transcribe a sequence from a sequencer using the Transcription Mode
If you’re interested in notating a performance that’s currently stored in a hardware or software
sequencer, you have several options. If your sequence is stored in a sequencing program (software), you can usually transfer it to Finale by saving it as a standard MIDI ﬁle; read your
sequencer’s instructions, then see MIDI FILES –To import a MIDI ﬁle for instruction on converting a MIDI ﬁle to standard notation.
If the sequence is stored in a physical (hardware) sequencer, or if you have a second computer
equipped with its own MIDI interface, you can plug the sequencer (or extra computer) into your
computer and play the sequence into the Transcription Mode window. As far as Finale is concerned, the MIDI signals it’s receiving in this way are no different from the ones you produce
when you play your synthesizer. The Transcription Mode can record tracks simultaneously from
as many MIDI channels as you like, and then transcribe up to four channels at a time.
• Create the empty score, including meter, key signature, and staff conﬁguration. You can
transcribe onto one or two staves at a time.
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•

and select Transcription Mode from the HyperScribe
Click the HyperScribe Tool
Menu. Click the measure at which the transcription will begin. You enter the Transcription
window. If the sequence is capable of providing a MIDI “click track,” or if you can add a separate track consisting solely of quarter-note (or some other value) “clicks” on a single pitch,
TOC
you’ll save time in the long run, because Finale will be learning where the beats fall at the
same time as it’s hearing the music. If your sequence does not contain a click track, skip to the
instruction marked by the asterisk (*).

•

Choose Click Input from the Time Tag Menu. Specify the incoming MIDI signal that will
serve as the click. The easiest way to enter the click description is to click Listen, and then
play the click itself. Note that if the click itself is to be a pitch, make sure it’s either a very high
Next
or very low pitch—one that won’t be mistaken for a note in your sequence.

•

Click Ignore First Data Byte (so that it’s no longer selected). This checkbox essentially
tells Finale whether or not it should be particular about the MIDI signal it’s interpreting as
Previou
Time Tag information—in other words, whether or not to consider any key (or controller) to Chapter
be a Time Tag. You don’t want this option selected, because you’re going to record both Time
Tags and keyboard notes simultaneously.
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•

Click OK (or press enter). If the clicks will be “tapping” any duration other than a quarter
note, be sure to let Finale know by choosing the correct duration value from the First Tag is
submenu of the Time Tag Menu.

•

Click Record under the words Time Tag. If the sequence won’t be providing a click track,
leave Play selected under the words Time Tag; you can add the Time Tags separately after
you’ve recorded the sequence.
TOC

Index

*
•

Click Wait Till. Finale is now in “pause” mode, where it will remain until it receives the ﬁrst
MIDI signal from the external sequencer.
Next
Play the sequence. Click anywhere (except on a button) to stop recording. When you stop Chapter
recording, you’ll see your music expressed as a sort of scrolling horizontal bar graph; the
lengths of the bars indicate the durations of the notes, and their position in relation to the piano Previou
keyboard (left side of the screen) indicates their pitch. If you recorded the Time Tags (“click Chapter
track”) as the sequence played, you’ll also see note icons at the top of the screen, indicating
the placement of the beats.

•

To play your performance back, choose Select All from the Edit Menu; under the word
Keyboard, click Play; then click Start. You hear the sequence played back. Note that Finale
records the MIDI channel information from the sequence, too; when it plays back, it will
transmit the MIDI signals over the same channels on which they were received. Keep this in
mind if you’re having trouble hearing all the tracks in the sequence when you play it back.

•

If the sequence didn’t contain a click track, add Time Tags. See To transcribe a sequence.

•

Select the MIDI channel and pitch information to be transcribed by choosing Transcription Filter from the Transcription Menu. The Transcription Filter dialog box appears, in
which you can specify the range of notes within each MIDI channel you want transcribed.
For example, if your sequence contained tracks recorded on several different MIDI channels,
you can now transcribe them onto individual staves, one at a time; if the ﬂute and clarinet were TOC
both on channel 2, for example, enter 2 in the ﬁrst MIDI channel text box. Then, to make sure
you only transcribe the ﬂute part, enter the highest and lowest notes of the ﬂute’s register in
the Key Range: High and Low text boxes. (To enter this information by playing it, click LisIndex
ten; play the lowest note, and then the highest note of the range you want to specify.)
You can also use this high note/low note ﬁlter in reverse. If, for example, you specify a Low
note that’s higher than the High note, you’ll have deﬁned a range of notes you want to omit
Next
from the transcription; only notes lower or higher than the speciﬁed range will be transcribed. Chapter

•

Click Use Filters. You’ve just told Finale, in terms of MIDI channel and range of notes, what
it should extract from the complete sequence for notation onto its own staff. When you’re ﬁn- Previou
ished transcribing this element, you can return to the Transcription window, choose Transcrip- Chapter
tion Filter again, and specify the next MIDI channel setting to extract the next “track” out of
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the sequence, and so on, until you’ve ﬁltered out each individual “track” from the sequence.
•

Choose Assign Measure Tags from the Time Tag Menu. For each downbeat, Finale automatically puts a tiny M above the other Time Tags in the Time Tag display area, according to
the time signatures in the score itself.

•

If you’re transcribing onto two staves, choose a split option (Fixed or Moving) from the
Split Point submenu of the Transcription Menu. If you choose Fixed, a dialog box appears.
Enter the number of a synthesizer key whose pitch you want to designate as the dividing point
between upper staff (usually treble clef) notes and lower staff (usually bass clef) notes. (Or, if TOC
you prefer, click Listen and play the key.)

•
•

•
•
•
•

•

If you choose Moving, Finale will split a two-handed performance onto the correct staves (treble clef or bass clef) by tracking the positions of your hands as they move up and down the
keyboard. Enter (or, by clicking Listen, play the interval of) the largest hand span (in half
steps) that occurs in the sequence. As long as there’s a discernible gap between your two
hands, Finale can track a changing split point automatically. Click OK to exit either Split dialog box.
Click Quant Settings in the Transcription window. The Quantization Settings dialog box
appears.
Choose a smallest note value and type of quantization. Choose the smallest predominant
note value in the piece. Select either Mixed Rhythms, Space Evenly (for a swing feel) or No
Tuplets. See QUANTIZATION SETTINGS DIALOG BOX for more information.
Click More Settings. The More Quantization Settings dialog box appears.
If you like, click Key Velocities, Note Durations.
Click OK twice.
If you like, click Save Continuous Data, and Save Tempo Changes. When the dialog box
appears (when you click Save Tempo Changes), press enter.
These four options tell Finale to remember the precise feel of the original performance, and to
keep this data handy for playback once you return to the score. If you don’t choose these
options, then when you play back the transcribed music from the score, Finale will simply
play back the sheet music—mechanically reproducing the notes, but without expression or
feeling—instead of an exact re-creation of your original performance.
Click the Transcribe button. If the results aren’t perfect, remember that your performance is
still intact, in the Transcription window. Click the ﬁrst measure of the transcribed notation to
switch back into the Transcription Mode, where you can correct any split point or quantization
settings; then click Transcribe again.
If you still don’t get good results and you can’t ﬁgure out what’s wrong, read the section
called Quantization Settings Guide in the Appendix. If you discover occasional split-point
errors in the transcription (where a right-hand note was notated on the left-hand staff, for
example), see RECORDING WITH HYPERSCRIBE–To correct split point errors and QUANTIZATION SETTINGS GUIDE.

To transcribe a performance
•

Record the music. See “To record a performance,” above.
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Choose Select All from the Edit Menu. The display area is highlighted. You’re about to tap
along with your music as it plays back, providing Finale with a tempo point of reference. These
taps are called Time Tags.
Choose a rhythmic value for your taps from the First Tag is submenu of the Time Tag
Menu. If you plan to tap even rhythmic values (all quarter notes, for example), also choose
Record Equal Durations from the Time Tag Menu. (If you don’t select Record Equal Durations, you can actually vary the rhythmic value of your tap—sometimes eighths, sometimes
quarters—and Finale will attempt, by interpolating and extrapolating, to assign the Time Tags
TOC
correctly.)
Under the word Keyboard, click the Play option. There are two distinct layers of MIDI
information in the Transcription Mode: the Keyboard layer, which records every aspect of
your synthesizer performance, and the Time Tag layer, which records only your beat taps. You
want the Keyboard layer to play while you record the Time Tags.
Under the words Time Tag, click Record. If you’re about to generate Time Tag taps on any
channel other than MIDI channel 1, choose Click Input from the Time Tag Menu. Click Listen
to MIDI, and play the note (or MIDI controller) you’ll be tapping. Click OK.
Click the Wait Till button. Finale goes into pause mode, where it will remain until you touch
a key or pedal on the synthesizer.
Tap any key in time to the music. Click anywhere (except on a button) to stop recording. If
you need to start over, choose Select All from the Edit Menu and repeat the last four steps.
When the music ends, Finale automatically stops recording, and you should see small note
symbols (Time Tags) across the top of the screen.
Choose Align Tags to Notes from the Time Tag Menu. This command “quantizes” your taps
to the nearest notes.
A small dialog box appears, asking you to specify the search width. The number in this text
box, in thousandths of a second, tells Finale how far from each tag it may “search” for a note
with which to align it. If the performance was slow, you can increase this number; if it was
very fast and “notey,” you may want to use a smaller number (so as not to move a Time Tag
inadvertently to the note after the one with which it should align, for example).
In most cases, however, you can simply keep the default search width setting (200 thousandths
of a second).
Click OK (or press enter).
Choose Assign Measure Tags from the Time Tag Menu. Finale automatically puts a tiny M
at the beginning of every measure, according to the time signature (or time signatures) you’ve
already established in the score itself.
If your piece has several different time signatures but you haven’t already established them in
the score, choose Measure from the Time tag Menu and repeat the tapping process, but this
time tap at each downbeat. When you’re ﬁnished, choose Convert to Time Signatures from the
Time Tag Menu; this will automatically create time signature changes in the correct measures
in your score.
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If you’re transcribing onto two staves, choose a split option (Fixed or Moving) from the
Split Point submenu of the Transcription Menu. If you choose Fixed, a dialog box appears.
Enter a synthesizer key number at which to split the performance into two staves. (Click Listen, if you prefer, and play the key.)
If you choose Moving, a dialog box appears in which you can enter (or, by clicking Listen,
play) the largest hand span that occurs in your performance (in half steps). This doesn’t necessarily mean the widest interval you can play with one hand; rather, it means the widest interval
you played in the piece. When transcribing, Finale will attempt to split your two-handed performance onto the correct treble- and bass-clef staves by tracking the positions of your hands
as they move up and down the keyboard. As long as there’s a discernible gap between your
two hands during the performance, Finale can track a changing split point automatically.
Click OK to exit either dialog box.
Choose a smallest note value and type of quantization. Choose the smallest predominant
note value in the piece. Select either Mixed Rhythms, Space Evenly (for a swing feel) or No
Tuplets. See QUANTIZATION SETTINGS DIALOG BOX for more information.

•

Click More Settings. The More Quantization Settings dialog box appears.

•

Select Include Voice Two if desired. If there are few places where you’ll be needing an inner
voice, however, don’t select this option. This will prevent Finale from creating secondary
voices where you didn’t intend them—for example, where two successive notes were accidentally overlapped in the sequence. The status of this option can have a dramatic effect on the
“cleanness” of your transcriptions. Use the Retranscribe function in the Mass Edit Menu to
correctly place Voice 1 and Voice Two in the few places you want them. See RETRANSCRIPTION.
If you like, click Key Velocities, Note Durations.
Click OK twice.
If you like, click Save Continuous Data, and Save Tempo Changes. When the dialog box
appears (when you click Save Tempo Changes), press enter.
These options tell Finale to remember the precise “feel” of your original performance, and to
keep this data handy for playback once you return to the score. Save Key Velocities tells
Finale to retain key velocity information (see KEY VELOCITY). Save Note Durations preserves
Start and Stop Time data, such as rolled chords and swing (see START AND STOP TIMES); Save
Continuous Data retains continuous data (pedal, pitch bend, and so on); and Save Tempo
Changes captures your tempo ﬂuctuations, including ritards and accelerandi. If you don’t
choose these options, then when you play back the transcribed music from the score, Finale
will simply play back the sheet music—mechanically reproducing the notes, but without
expression or feeling—instead of exactly re-creating your original performance.
Click the Transcribe button. If the results aren’t perfect, remember that your performance is
still intact, in the Transcription window. Click the ﬁrst measure of the transcribed notation to
switch back into the Transcription Mode, where you can correct any split point or quantization
settings; then click Transcribe again.

•
•
•

•
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If you still don’t get good results and you can’t ﬁgure out what’s wrong, read the section
called Quantization Settings Guide in the Appendix. If you discover occasional split point
errors in the transcription (where a right-hand note was notated on the left-hand staff, for
example), you can either change the split point settings in the Transcription window and try
again, or simply go to the score and ﬁx the wrong notes manually. See RECORDING WITH
HYPERSCRIBE–To correct split point errors and QUANTIZATION SETTINGS GUIDE. See also
QUANTIZATION SETTINGS DIALOG BOX, MORE QUANTIZATION SETTINGS DIALOG BOX and
RETRANSCRIPTION.
TOC

To edit Time Tags
Sometimes you need to change the durational value of a Time Tag, or move the Time Tag so that it
aligns with a note, or to add or remove a Time Tag completely. The following instructions assume
you’ve already recorded a performance and entered Time Tags, as described in “To record a performance” and “To transcribe a performance,” above. They also assume that you’re still in the
Transcription window.
• Click the words Time Tag. The words become highlighted. You’ve just indicated that you’ll
be editing Time Tags only. For better control, you can “zoom in” by choosing View Resolution
from the Transcription Menu. In the dialog box that appears, enter a smaller value to enlarge
the display—50, for example; click OK.
•

To insert a new Time Tag, double-click in the Time Tag display area. The Time Tag display area is the top strip of the display window, where the Time Tags appear (in a line with the
small metronome icon). When you double-click, a new tag appears, whose duration is determined by the First tag is setting in the Time Tag Menu.

•

To move a Time Tag, drag its notehead. If you select a group of tags (by dragging through
them or by choosing Select All from the Edit Menu), you can drag any one notehead to move
them all.

•

To change the duration of a Time Tag, carefully double-click its notehead; on the second
click, hold the button down. Drag it to the left or right. As you drag, the Time Tags cycle
through the durational values: sixteenth notes, eighth notes, quarter notes, and half notes. Drag
to the right for larger values, to the left for smaller values. By selecting a range of tags (by
either dragging or by choosing Select All from the Edit Menu), you can use this technique to
effectively renotate an entire piece at once. You could change a
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piece to cut time, for exam- TOC
ple, by changing quarter note Time Tags to eighth note Time Tags; you’re effectively telling
Finale that every quarter note is now an eighth note. (If you try this, however, don’t forget to
choose Assign Measure Tags again from the Time Tag Menu before clicking Transcribe.)
Index

To edit keyboard notes
While it’s much easier to edit your performance once it’s been transcribed into standard notation,
you can, if you wish, edit notes directly in the Transcription window.
• Click the word Keyboard. The word becomes highlighted. You’ve just indicated that you’ll
be editing notes only. For better control, you can “zoom in” by choosing View Resolution
from the Transcription Menu. In the dialog box that appears, enter a smaller value to enlarge
the display—50, for example; click OK.
• To delete notes, drag through their starting point and press delete.

Next
Chapter
Previou
Chapter

Transcribing a sequence

17-49

•

To insert a new note, double-click in the Keyboard area. The Keyboard area is the bottom
three-quarters of the display window, where the other notes appear. When you double-click, a
new note appears, whose pitch is determined by the location of your click; use the piano keyboard at the left side of the screen as a guide.
Technical note: The note’s initial duration is 15 units; the value of a unit is determined by the
number in the View Resolution dialog box. In other words, if the View Resolution (the unit) is
100 (in thousandths of a second), the note produced by a double-click is 1500 thousandths of a
second long—which is 1.5 seconds. If you hold the mouse button down on your second click,
TOC
you can drag backward (to the right) to increase the duration of the note.

•

To move the attack (or release) of the note, carefully double-click the line; on the second
click, keep the mouse button down and drag the ﬁrst (or second) half of the line right or Index
left.

To add tracks
In a true sequencer program, you can record a new “track” while listening to a previously
recorded “track.” Using the Playback Controls and the Transcription Mode, you can accomplish
the same effect in Finale.
• Record the ﬁrst track. Transcribe it in the usual way. See “To record a performance” and
“To transcribe a performance,” above.
• Choose Playback Controls from the Windows Menu. The Playback Controls appear.
If you chose Save Key Velocities, Save Note Durations, Save Continuous Data, and Save
Tempo Changes while you were in the Transcription Mode, you can now instruct Finale to
play the music back with your original “feel,” including tempo ﬂuctuations and pedaling.
• Click the expand arrow; then click Playback Options. If you want to hear the alreadyrecorded music played back exactly as you recorded it, make sure the four Play
Recorded _____ checkboxes are selected. Click OK. At this point, listen to your score to
make sure the tempo and MIDI channels are set correctly. You can’t change any aspects of this
“already-recorded track” beyond this point.
You’re about to create a Playback File of the existing score. A Playback File is an audio version of the current score (not the same thing as a Note File, which can only be created from
within the Transcription Mode). If you only want to record a new track over part of your score,
specify the range of measures you want to include in the Playback File using the Play From
and Play Through controls.
• Click Save File. A dialog box appears.
• Give your Playback File a title, and click Save. You can close the Playback Controls, if you
wish.
•

•
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and select Transcription Mode from the HyperScribe
Click the HyperScribe Tool
Menu. Click the target measure for the transcription of the next track. You enter the Transcription window. The Background File checkbox now has an X in it; Finale has automatically
“loaded” your playback ﬁle into the “background,” so you’ll hear it playing when you record
your new track. (If you don’t want to hear the old track playing back, click Background File
and click Cancel.)
Choose New from the File Menu. Any music left in the window is now cleared.
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Click Start or Wait Till. Now play your second track. Click anywhere (except on a button) to stop recording. Finale plays your Background File as you record the new track. If you
haven’t clicked the mouse, Finale automatically stops recording when the Background File
ends.
Choose Select All from the Edit Menu.
Choose Create Tags From Background File from the Time Tag Menu. Finale assigns Time
Tags to the new track based on their positions in the Background File (your original track),
saving you the trouble of having to record them again.
Choose Align Tags to Notes from the Time Tag Menu. This command “quantizes” your taps
to the nearest notes.
A dialog box appears, asking you to specify the search width. The number in this text box tells
Finale how far from each tag it may “search” for a note with which to align it. If the performance was slow, you can increase this number; if it was very fast and “notey,” you may want
to use a smaller number. In most cases, however, you can simply keep the default search width
setting.
Click OK (or press enter).
Choose Assign Measure Tags from the Time Tag Menu.
From the Transcription Menu, choose your quantization value, split point, and other
transcription options. For a complete discussion of these options, see “To transcribe a performance,” above.
Click the Transcribe button. You can repeat this process as many times as you like, building
staff after staff, track after track. Just create a Playback File of each transcribed track before
proceeding to the next. (Note: You don’t have to include all existing staves in each Playback
File. See PLAYBACK for instructions on muting nonessential staves.)
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Split points
To specify a point at which a measure may split across a system (line) break, see MEASURES—To
split a measure across a line break.
You’ll need to specify a different kind of split point when you use Finale’s real-time transcription
tool to transcribe a two-handed keyboard performance. Since the computer can’t “see” your
TOC
hands, you must tell it how it should split your performance onto the two staves.

To specify a ﬁxed split point
To enter HyperScribe, click the HyperScribe Tool. The HyperScribe Menu appears. To enter the
Transcription window, click the Transcription Mode, then click the measure where the transcription is to begin. See RECORDING WITH HYPERSCRIBE or TRANSCRIBING A SEQUENCE.
• From the Record submenu of the HyperScribe Menu choose Split into Two Staves or
from the Split Point submenu of the Transcription Menu choose Fixed. The Fixed Split
Point dialog box appears, letting you enter a number. The number refers to a speciﬁc note on
your MIDI keyboard; middle C is key number 60.
•

Click Listen. Finale displays a message, telling you that it’s listening.
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•

Play the MIDI note you want to designate as the split point for your transcription. If your
MIDI equipment is set up properly, the number in the Split MIDI Note text box changes. (You
can also type a number directly into the text box.) When Finale transcribes your performance,
all notes below the note indicated will be put on the lower staff; all notes above, including the
speciﬁed note, will be on the top staff.

•

Click OK (or press enter). If your piece has no clear split point, you may ﬁnd it easiest to
record the right-hand part an octave higher than written. After Finale transcribes the piece, it’s
a simple matter to transpose that staff to the proper register (see TRANSPOSING: BY INTERVAL).
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To specify a movable split point (Transcription Mode only)
If the piece you intend to transcribe doesn’t have any one split point—in other words, if the ranges
of notes played by your right and left hands during the piece aren’t completely distinct—you can
use Finale’s Moving split point feature. Finale will split a two-handed performance onto the correct staves (usually treble and bass clef) by tracking the positions of your hands as they move up
and down the keyboard. As long as there’s a discernible gap between your two hands at any given
moment, Finale can adjust the split point on a note-by-note basis automatically.
• From the Split Point submenu (of the Transcription Menu), choose Moving. A dialog box
appears.
•

Click Listen, and play a one-hand-width interval on the synthesizer keyboard. Don’t necessarily play the widest interval you can reach. Instead, play the largest interval you played
with one hand in the piece; strike the two notes comprising your hand width more or less
simultaneously. The number in the Hand Width text box, measured in half steps, changes to
reﬂect the interval you played. (Instead of clicking Listen, you can also enter a number
directly into the Hand Width text box.)

•

Click OK. If Finale still makes a few errors in the resultant transcription—for example, if
your hands were, at some point, too close together for Finale to track them—see To correct
split point errors.
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To correct split point errors VISUAL DEMO
Occasionally, because there is no clear split point, or because your hands cross, a HyperScribe or
Transcription Mode transcription will contain left-hand notes in the treble-clef staff, or right-hand
notes in the bass-clef staff. Using the Note Mover Tool, you can quickly restore the notes to the
TOC
proper staves. See NOTE MOVER TOOL.

u. The Note Mover Menu appears.

•

Click the Note Mover Tool

•

Choose Delete After Merge from the Note Mover Menu. In other words, you’ll delete the
incorrectly split note from its current staff, and merge it with the correct staff.
Click the measure containing the incorrectly split notes. A handle appears on each notehead.
Select the notes to be moved. Select one note by clicking its handle, several adjacent notes by
drag-enclosing them, or additional notes by shift-clicking (or shift–drag-enclosing them). The
handles you select are highlighted.

•
•
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Drag any highlighted handle onto the target staff. Don’t drag it to any particular line or
space; just drag it anywhere onto the correct staff. The notes are automatically transferred to
the correct lines or spaces of the new staff.
Note: If you are not pleased with the results check your quantization settings in Quantization
Setting dialog box in the Options Menu. Also the More Quantization Settings dialog box. See
QUANTIZATION SETTINGS DIALOG BOX and MORE QUANTIZATION SETTINGS DIALOG BOX.

Swing

TOC

For a discussion of creating playback with a swing feel, see Installation & Tutorials.
The most common convention is to notate “swung” eighth notes as standard eighth notes, with the Index
word Swing above the score (usually on the ﬁrst page, with the tempo marking). Finale follows
this convention in transcribing real-time performances.

To notate swing performances (HyperScribe)
•
•
•

•
•
•
•
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From the Options Menu, choose Quantization Settings. The Quantization Settings dialog
box appears.
Previou
Select a Smallest Note Value. See QUANTIZATION SETTINGS DIALOG BOX for more informa- Chapter
tion.
Select Space Notes Evenly in Beat. Finale will notate swung eighth notes as normal eighth
notes, but will accurately notate triplets if you play them. Note: It’s a good idea to tell Finale
beforehand exactly how you want the triplets notated—whether or not they should have a
bracket or slur, and so on. Instructions for deﬁning the default tuplet appearance can be found
under DOCUMENT OPTIONS-TUPLETS.
Click More Settings. The More Quantization Settings dialog box appears.
Select Soften Syncopations. See MORE QUANTIZATION SETTINGS DIALOG BOX for more
information.
Click OK twice.
Record your performance. See RECORDING IN HYPERSCRIBE–To record into one or two
staves.
Note: For other ways to create a swing performance see MIDI –To create swing playback.
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To notate swing performances (Transcription Mode)
You can also transcribe swing performances with the Transcription Mode. The process is roughly
Index
the same, but the steps are slightly different.
•

•
•

g

Click the HyperScribe Tool
and select Transcription Mode from the HyperScribe
Menu. Click the measure at which you want the transcription to begin. You enter the
Transcription window.
Record your performance in the usual way. See “To record a performance,” above.
Click the Quant Settings button in the Transcription window. The Quantization Settings
dialog box appears.
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Select Space Notes Evenly in Beat. Finale will notate swung eighth notes as normal eighthnote pairs, but will accurately notate any triplets that occur. See QUANTIZATION SETTINGS
DIALOG BOX for more information. Note: Again, you can tell Finale beforehand exactly how
you want the triplets notated—whether or not they should have a bracket or slur, and so on.
Instructions for deﬁning the default tuplet appearance can be found under TUPLETS.
Click OK.
Continue the transcription process in the usual way. Again, see “To transcribe a performance,” above.

Punch in/Punch out
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To to perform a punch in and out
Punch in and punch out are sequencing and recording terms. They refer to the act of rerecording,
in a second pass, only a portion of a performance you’ve already recorded, allowing you to
rerecord only a ﬂawed part of a performance that was otherwise perfect, for example.
You can punch in and out in Finale’s Transcription window. By clicking the Keyboard Play radio
button and the Time Tag Record radio button, you can also rerecord Time Tags for a certain passage. For further instructions on the use of the Transcription Mode, see TRANSCRIBING A
SEQUENCE. You can tell Finale to play a “countoff” measure or so of music before switching to
“record” mode, if you want.
• Record your performance in the usual way. Again, see TRANSCRIBING A SEQUENCE for
complete instructions.
•
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Specify the region you want to rerecord. To tell Finale what region you want to rerecord,
you need to enter the exact starting and stopping times in the In and Out counters (in the
lower-right corner of the screen). These indicators specify the starting and ending points of the
selected region, expressed in the Hours:Minutes:Seconds:Thousandths of a second format. To
edit these numbers directly, click the word In or Out, and type new values.
You may ﬁnd it easier to select a region by simply dragging through a section of the display
area. These counters change automatically to reﬂect your selection. You can also set either
indicator by clicking—click the word In or Out, and then click in the display area.
TOC

Note: To locate the places where you want to punch in and out, drag through the keyboard display area of the Transcription window, so that a portion of it is highlighted. Under the word
Keyboard, click Play; click Start to listen to the highlighted music. Repeat the process until
Index
you’ve located the exact places in the music where you want to punch in and out.
•

Under the word Keyboard, click Punch In/Out.

•

Choose Punch In Preroll from the Transcription Menu. You’ll probably want Finale to
play a few seconds of the music just before the spot you want to rerecord, so you can hear the
desired spot in context and in tempo. The dialog box that now appears allows you to specify
how many seconds of the existing music you want Finale to play before switching into record
mode (at which point you’ll begin to play the new music).
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Punch in/Punch out
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•

Enter the number of seconds of preroll you want. Click OK (or press enter). You’re now
ready to begin.

•

Click Start. Finale plays the music preceding the punch-in point for the number of seconds
you speciﬁed, and then begins recording your new performance. When Finale reaches the
point you speciﬁed as the punch-out point, it stops recording.
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